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Introduction

Introduction
Every Optical System Has 3 Components: Capture, Process, Output
Photography, film or digital, has many
similarities. Photographic processing has been
around for well-over 150 years. Although there
are many differences between film and digital
processing, there are areas that are common to
both: controlling highlights; shadows; contrast;
dynamic range; etc. We can benefit from our
years of film processing when processing the digital image.
In this book I will present my “4-Phases” of processing the digital image:
1 - Convert

2 - Global

3 - Selective

4 - Expressive

These phases are not software-specific but are sound steps
following digital processing best practices.
This book will allow you to establish a basis of understanding along with an
importance of a consistent approach when processing your digital images.
With continuing improvements in digital processing software, the
opportunity is available to digital photographer to achieve their “Artist’s Vision”.
As with any creative discipline, there are 2 components – Craft & Creative.
The successful Digital Photographer needs to understand and control both. The
first 3 phases of digital image processing: Convert; Global; Selective are craft
oriented. The 4th phase, “Expressive” is creative - limited only by your creativity,
awareness and “Artist’s Vision”. As your awareness and experience of the craft
of processing grows, creativity in your photographs will also continue to grow.
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Photo History
Popular digital photography in the US is nearly 30 years old. It started with
the introduction of Kodak DCS (Digital Camera System)
100, based on a Nikon F3 body released in May 1991.
The images were 1.3 MP and stored on a monstrous 200
MB Digital Storage Unit (hard drive) that could store 156
images. It retailed at about $28,000
However, digital photography is a babe when
compared to silver-base film
photography – now closing in on
its 200th years! Fox Talbot’s “The Pencil of Nature” was
published in 6 installments between 1844 and 1846. It
was the first commercially published book illustrated with
photographs.
“It was wholly executed by the new art of Photogenic
Drawing, without any aid whatever from the artist's pencil!”
Digital Revolution #2
It has been more than 15 years since Tom Knoll, the father of Photoshop,
developed Adobe Camera Raw [ACR] format in 2007. This started, what I see as,
Digital Photography 2nd Revolution. Until then, most
digital photos were processed in the camera. The scene’s
data was rasterized into dots/pixel then saved in industry
standard .JPG format.
A simple explanation of raw is that the captured data
is not processed. The scene’s digital data, represented by
1s&0s, is captured by the camera’s sensor and saved
unprocessed to the camera card. This unprocessed data is saved to later be
digitally processed by your software. (Click 3 photos above to link to more info)
As Adobe’s ACR software continually improved, other quality raw processing
software started populating the digital processing market. Yet our raw data
captured by the camera never changed
– still waiting to be processed – anew!
The exciting fact about camera raw is
that software capability will continue to
expand, and, we’ll be able to re-process
our raw data captured 15+ years ago
with more options! In this example,
notice the tonal detail in shadow &
highlights; overall sharpness; rich color
in the bouquet.
Processed 2019
Processed 2005
My 4-Phases of Processing the Digital
Image takes full advantage of this powerful camera raw capabilities.
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Mobile Photography
Photography taken on Mobile Devices is the major source of picture-taking
today. InfoTrends estimates there are 1.2 Trillion digital images a year! …or 3.2
billion a day!! …or 133.333 million an hour!!! – and I would venture a guess that
95% of them are shot on smart phones [Click Here]
Photographing with your Camera-Phone is sometimes referred to as
“PHONtograph” or PHONEography. Call it what you will,
there is no denying its impact on photography today and
in the future. [Click Here for Camera Phone History]
Some long-time photographers look down at
PHONOgraphers. I have a photographer friend who feels
frustrated looking at people’s Camera-Phone photos. “They’ll say, ‘let me show
you my cat’ and then spend minutes trying to find the photo… then when found, it is
underexposed and out of focus – UGH!”

Make no mistake, most PHONOgraphers are visual people capturing exciting
images. They are committed to their photos: they get down on one knee for a
lower camera angle, stand on mailboxes for a higher camera angles; some have
given their lives leaning a bit too far for that “great selfie” [Click Here]
With that said, I appeal to all PHONOgraphers… if you’re serious about your
photography then you must be serious about the presentation of your images…
…your images should be shown the best they can be!
If you’re a PHONOgrapher and you want people to spend time looking at
your photographs, you owe it to the viewer to spend time and attentiveness
when processing your images.
“A photographer is known by what they show – not what they shoot”
The Importance of Mobile Photography
Many of the newer trends in digital photography are driven by these mobile
devices: Camera-phones with Portrait mode to blur background with a choice of
“bokeh”; multi-lens camera-phones saving “depth
map”… allowing for post-capture: focus; selective
adjustments; magnification; etc. [Click Here]
[ Sidebar]: Compendium: Mobile Photography
For a more in-depth look at this important aspect of today’s digital
photography, I have devoted an entire chapter in a compendium at
the end of this book – [Click Here]
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My Teaching Philosophy
My philosophy of teaching is “adaption not adoption”. I am not looking for
disciples, I am looking for fellow travelers… to share information and “kick this
can”, this digital photography experience, down the road together.
I have 50 years of a diverse photography background: working in Polaroid’s
research and development with experimental emulsions and sensitizing dyes,
teaching the Nikon and Time Life school of photography, a US Patent in color
printing, Adobe Certified in Photoshop Lightroom; yada, yada, a.k.a “etc.” …
and oh yeah, authored two books. (see full bio here)
About My Books
My first book discussed The Optimum Digital Exposure… this will discuss an
approach to optimize the processing of your digital images.
In this book we will talk about capture as it relates to the craft of
photography. We will not talk about “the decisive
moment” or the creativity of a photograph.
Though creativity is, (raison d'être), the reasonfor-being”, my personal thoughts on the creative
aspects of photography are more appropriately
discussed over a cup of coffee rather than some
pronouncements put in the book.
Accompanying Web Site
One thing we can say for sure, if the past has demonstrated anything, digital
processing will expand, providing us with more capabilities! Better algorithms
(Computational Photography); new processes (Epsilon Photography). This book
has a complementary web site: www.ProcessingTheDigitalImage.com . It is not
just supportive but integrated to follow this evolving medium.
Book Photo Examples and Links Are Posted on Website
It is possible that subtle processing adjustments may be hard to notice in
some book’s examples. All examples in this book are available to view on the
book’s website.
There are informative interactive active links throughout the PDF version of
book. This “globe” icon indicates active links. If the icon is attached
to a photo inset, click on the photo to follow the link. If the icon is
on a table of contents page, clicking the icon will direct you to the
website showing all examples in the section.
If you have the printed copy of the book, the URLs to all book’s links are in
the Appendix
Submit Photos
You are invited to submit your photos using the 4 Phase Workflow on the
book’s website. You’ll find these photos under “Submitted Photos” menu.
If you would like to submit photos for the PDI website, please see the
instructions in the Appendix of this book.
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Final Word
Book’s Purpose and Intent:
Two of the most critical events in photography are:
1) when we take the image in our camera… “the moment of capture”, and
2) when we process that captured image.
As photographers, to express our “Artist’s Vision”, we need to understand
both the Craft and Creativity of photography. There are many books exploring
the creative aspects of photography…it is the reason why we photograph!
In this book, I will talk about the photographic craft
as it relates to “Processing the Digital Image”.
And only attempt to show where in the process creativity is best applied
Choosing Your Software
- Even if you saved your digital photos in .jpg format, you can still benefit from
the non-destructive processing supported in my 4-Phases PhotoCycleTM
- Although my process is not-software-specific, the examples used in this book
are with Adobe Lightroom and Photoshop.
- Choosing a digital processing software is personal – there are many fullfeatured powerful software available. My take on software, use what your
friends and colleagues use… there’ll be lots of questions and you can share
knowledge with them.
Whichever software you chose, commit to learning its full power….
“Know your software, it will be the fastest way to get to your “Artistic Vision"
Post Visualization vs. Pre-Visualization
I feel one of the most significant difference between film and digital
photography is Pre-Visualization versus Post Visualization.
With film photography there was a lot of talk, and needed talk, of
Pre-Visualization – this was due to the limitations of the film process.
With digital photography, because of the power and continued advancement in
processing software, the availability of Post-Visualization has become a
powerful tool to help achieve our “Artistic Expression”.
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Moment of Capture & Artist’s Vision

I first want to talk about the Moment of Capture and the Artist’s Vision. As
photographers, our hope is to have our observations turn into expressive
photographs. Whether exposing analog film or capturing digital image - the
nature of light, and therefore photography, poses some unique challenges.
After the Moment of Capture, we process our image with the intent of
expressing our “Artist’s Vision”. Because of the limitation of the photosensitive
material, be it film or a digital sensor, fitting the tonal range of a scene on to
film or digital sensor certainly needs a good understanding or your craft.
However, I can say with surety…
…optimum digital exposure is the first step to optimum digital processing.
An interesting aside,
When photographing with film, “we take a picture”
When photographing in digital, we capture an image”.
…these 2 different approaches say a lot about the uniqueness of each media.
In either case, from the time we open the camera’s shutter- the moment of
capture [MOC] - to the time we show our photograph, the “Artist’s Vision” is
where the photographic processing takes place. To the next page you will see
photographic pairs of: the Moment of Capture and the final “Artist’s Vision”.
Curves of 2 Shapes
With film processing - there were limitations. The analog
curve could be bent, raised, shaped but it was always an analog
curve with increasing scene brightness following a linear path
from shadows (S) to Highlights (H).
With digital processing – there is no such limitation - just your
imagination and understanding your craft. The digital
photograph is captured, and the scene’s data saved in a file.
Unlike analog film, the digital processing “curve” does not
need to, and more likely will never, follow a linear path.
Processing the digital image is sometimes done for image
enhancement, other times it is done out of necessity. This book will discuss the
unique advantages of the digital processing tools to enhance our images.
Analog S-curve
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[Moment of Capture & Artist’s Vision]
“Artist Vision”

“Moment of Capture”

“Moment of Capture”
“Artist Vision”

“Moment of Capture”

“Artist Vision”

“Artist Vision”

“Moment of Capture”
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Tonal Relationship - The Photographic Challenge

The challenges of processing the digital image have to do with not only a
good understanding of the craft but its importance of placing the scene’s
dynamic range of tones on the camera’s sensor. (see examples on the opposite page)
a. Photographing under harsh light will cause strong contrast – washed-out
highlights and dark shadows;
b. Placing your subject in front of a bright sky will cause the person to be
silhouetted - underexposed;
c. Photographing your grandchild by a train window will drive the exposure
darker. Both these last two examples fool the camera’s light meter – what
photographers call “subject failure”;
d. Capturing early-morning kitchen-light will create hard shadows and various
pockets of challenging tonal relationships.
e. Conversely, on a gray overcast or hazy day, the scene will appear “flat” (lack
of contrast) and probably have a blue cast with very little tonal separation.
With such a “flat” scene, the digital processer has a wide extreme of
choices: to brighten; darken or expand the tonal relationship.
It is because of all these vagaries of capturing light for a digital exposure that
there is a need for processing your captured images.
Tonal relationships ARE the reason for Ansel Adams’ Zone System. It was
not an exercise in mental-photographic gymnastics but intended to better
balance the tonal challenges of a scene. Adams did this by calculating a unique
exposure for each scene, then, developing that negative specifically for that
scene.
Even with his careful exposure and complementing development for each
scene, there was still need for balancing tonal relationships. This “balancing”
took place in the photographic darkroom during printing, called “dodging and
burning”.
Ansel Adams has a great quote that also applies to digital photography:
“Dodging and burning are steps to take care of mistakes
God made in establishing tonal relationships.”
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The Photographic Challenge
[“…mistakes God made in establishing tonal relationship” – Ansel Adams]
Image Capture
Final Process

a.

b.

c.

d.

e.
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How & What Do We Capture?

Today’s digital cameras allow us to capture our data into
different formats: a processed JPEG,
a rasterize pixelized representation of the scene; or
a camera-raw file. The camera raw file format is
technically not an image but 1s&0s that represents
the scene’s brightness that was captured. Raw
captured files provide significant advantages over
the JPG file format.
As I mentioned earlier, the 1s&0s of the raw data
never changes! The first raw files captured in 2003
are now able to be processed years later with
software algorithms far beyond anything that existed in 2003… And, as software
expands its processing capabilities, these 2003 raw captures will be able to be
processed 20 years from now with software having far greater capability then
were using today!
If we look at the current state of digital cameras, most capture in 12-bit
format… That is 212 or 4,096 shades. The JPEG file is an 8-bit file 28 or 256
shades. It’s format limits the amount of colors captured… about 98% of them!.
The total # of shades are for each color channel [Red/Green/Blue]. So, to get
the total # of colors in a JPG file, we need to multiply 256 × 256 × 256 or a total
of 16,000,000 (16 million) colors. To get the total # of color in a 12bit raw file,
we need to multiply 4096 × 4096
× 4096 or 68,000,000,000
(68 Billion) colors. That is 4,000X
more shades captured in the
raw file when compared to a
JPEG file. This should be enough
to understand the importance of
shooting camera raw format.
Besides the obvious advantage of 4,000x more color data, Raw capture:
1. also provides us non-destructive processing working with the original
unprocessed data.
2. the originally captured 1s&0s of raw data never changes!
3. we can reprocess the original camera raw capture years in the future as
digital processing software capability keeps expanding
[Sidebar]: Capture

Today’s digital cameras have not evolved much in the last 5 years, however,
in that same time, processing software, with new sophisticated algorithms
and artificial intelligence, has grown significantly
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You Say What? What Did You Say?

Are you sitting down? Are you ready for a head-scratcher?
10% of your digital image is captured by your camera…
The other 90% of your digital image is created by your processing software!
And that’s assuming an optimum exposure which, in my teachings,
is done maybe 2% of the time - mostly by accident.

10% of your digital image
is captured by your camera

90% of your digital image
is created by your software

“Get It Right in the Camera”

I think one of the most misunderstood concepts when photographing is the
NOT Optimum
term, “Get It Right in the Camera”. I think it is misunderstood
because, what are we trying “to get right” …
the gesture, the perspective, the decisive moment...
these are what make a photograph.
I can tell you what you don’t want
The optimum exposure is done in the camera…
…the final exposure is done in the processing.
Optimum Exposure
Capturing the optimum exposure* - is the Craft of the photographer.
Capturing the “decisive moment” - is the Creativity of the photographer.
*Optimum exposure varies depending on the light-sensitive material that is exposed: B &W
negatives; color negatives; color slide film (chrome); digital capture – they all have different
“Optimum” exposers. I urge you to read my 1st book The Optimum Digital Exposure.

The Photographer’s Mantra:

Optimum Exposure is the first step in Optimum Processing
[ Sidebar]: The Difference Between JPEG vs. Camera Raw
I say, it is the difference between "cream" and "milk"…cream is thicker and has more
“butter-fat” (data) when poured. For those satisfied with that explanation, please shoot
Camera Raw.
For those who need a little more convincing, let me quote Bruce Fraser (Real World
Camera Raw): “…when you shoot JPEG, you’re trusting the camera’s built-in raw converter to
throw away a large amount of the captured data… about a stop of usable dynamic range, and
you have essentially no control over what gets discarded.
That satisfied me…If you still need coaxing, read Bruce Fraser’s 3-page definitive holy grail
“Understanding Digital Raw Capture”. (see appendix)
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Who Needs Digital Processing and How Much?

“Isn’t digital processing just for
photo enthusiast, the ones with
that very expensive and heavy
cameras?” “Nope”, it’s for
everybody - from the pro to the
point-and-shoot camera to
Camera-Phones.
Whether you are aware of it or
not, digital processing takes place
on every image shot, whether
shooting with a heavy DSLR, a
point-and-shoots or a Camera-Phone. Digital processing is done on every digital
image that is shot… yes, that’s right every one of the 3.2 billion photo per day!
(see PHONtography next page)

The Future (Digital Photography)
With artificial intelligence and machine learning assisting the advancements
of digital processing software, there are many
aspects of digital processing that can be automated.
However, no matter the advancements, it’s hard to
see the replacement for when the photographer’s
decision to trip the camera’s shutter or makes
expressive software edits.
Pondering the future advancements in digital photography, it became
apparent to me that the start of the creative process – [moment of capture] and
the end of the creative process – [Artistic Expression] are both the domain of the
Photographer/Processor – that would be YOU!

HOW MUCH TIME TO SPEND PROCESSING?

Proportionate to the
amount of time you
want someone to
look at your photos!
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Freedom from Process

For creative people, the thought of following a procedure can have
a chilling effect. The free-form nature of art has long been held
sacred – and necessary to the creative process. However, ask any artist and they
will tell you that practicing their craft was the key that gave them freedom to
express.
There is a wonderful quote by Graciela Danliele, a Broadway choreographer
who worked with the magically talented Chita Rivera. She said of Chita,
“she liberates herself from the technical part, then…
She can have the freedom of expression.”
Working in the analytical lab at Polaroid’s Research and Development, we
were taught a scientific method to
quickly achieve results and trends. We
either doubled of halved the previously
tested value. It was the quickest way to
come with the confident and trusted
results.
Pick-a-Card
I’m a father of two boys. When they were young, I would always play the
“pick a card, any card” game. They would pick a card and I would then try to
impress them with my magical powers by guessing their card. “Is it red?” With
their response of “no” I just ruled out 50% of the cards. I would then ask, “is it
a club? With another response of “no”, I just ruled out 50% of the 50%
choices… 2 incorrect answers ruled out 75% of the possibilities. My boys were
impressed, “you’re getting really close dad”. I then asked, “was it higher or lower
than the 7?” …well, you get the point. With 2 wrong answers and a qualifying
question I ended up with 6 options - I ruled out about 90% of the 52 cards!
50%
25%

10%

100%

So, what is the creative part here – the freedom from process? Process leads
to discovery. If you try this with several decks of card, what seems a mundane
repetitive task, you may think nothing would be different – or, you just may
notice that although all decks have 52 cards – but wow, those Aces of spade of
each deck are very different.
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The Creative Process Funnel / Drilling Down

When processing the digital image, I find the Freedom of Process this “funneling” / “narrowing” / “paring-down”, helps me in a similar way. Using
a constant 4-phases workflow helps me achieve find my artistic expression.
We are about to explore the PhtotoCycleTM.- the digital processing workflow.
We’ll look at each of the 4-Phases of processing the digital image refining our
image with each subsequent phase:
- The 1st Phase - Convert, changes the camera’s digits (1s&0s) to dots (pixels).
Although there is a lot of processing being done during converting, there is little
involvement from the photographer - especially after setting some camera
development defaults for each your camera. (I will explain more in Phase-1)
- The 2nd Phase - Global, adjustments needed to generally correct the entire
image - stopping when we get the image “most-correct”.
- The 3rd Phase - Selective, addresses those local areas that couldn’t be
adjusted satisfactorily with the global adjustment - such as: blocked shadows,
washed out highlights, lack of detail in my granddaughter’s dress, needing a
little “punch” in the clouds and a “bluer” sky (a deeper awareness image’s tonal
relationships)

- The 4th Phase - Expressive, where we make that expressive photo. Can’t
really tell you what gets done here – sometimes it surprises me. I make
adjustment I was not aware of when shooting, or when I selected the photo to
process when reviewing my shoot – true Post-Visualization!
Here is where we find the time spent with our image in the first 3 phases
allows us to better express our “Artist’s Vision”.
Please don’t underestimate the power of process – it can be very liberating!
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The Big Picture: Software Considerations
Before we get to discussing each of the 4-phases in detail, I need to
discuss the big picture - considerations of features needed in your
digital processing software. I will explain many of these features more in the 4Phases of Digital Image Processing section of this book. For now, here is an
overview of some considerations
Some of the specific features you want in your software:
• the ability to do both global
and selective adjustments –
(this is in most every software)

• the ability to do pixel
replacement. There will be
part of your picture, both necessary and creatively, where you will want to
remove or add pixels.
• the ability to save camera-specific default develop settings. Not all software
will support this feature, but this ensures the most mundane, but
important, aspect when converting those digits to dots.
• the ability to be able to process non-destructively – this is called Parametric
Image Editing [P.I.E.] Adjustments do not change pixels but are
parametric/mathematical adjustments that get applied to the file’s 1s & 0s.
These changes get “baked” into the photo when output. (the key term used
mostly is “Smart Objects")

• the ability to support One Master File with many “children”. These
iterations (sometime called virtual copies) can have different processing but
any changes to the Master File “ripples” through the children.
There are many software other than Adobe Lightroom* & Photoshop* that
people are using successfully and creatively. My take on the software: - "know
your software” Become aware of its tools and their extensive range of uses…
You will get to your “Artistic Expression” faster… And, more Expressively!
However, it’s important to know that:
4-Phases of Processing the Digital Image is not software specific!
[Book Examples]

Most examples used in the book are from Adobe Lightroom and Photoshop
software. I started using Photoshop in 1992 version 2.5 and LR from the beta
version April 2007… hard to turn back now.
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The Big Picture: Working with Smart Objects & P.I.E.
In this example, I resized two files – a pixel-based file and a “Smart Object”
file. I downsized both files 10%. I then resized the 10% reduction back to the
100%. The results are obvious.

The pixel file, when reduced, discarded 90% of the data. When resized, it had
to create 10x more pixels than it had – the results are unusable!
The “Smart Object” file applies Parametric calculations to the original data.
When resized, it just applied another parameter to the original data… no
destruction of the imaged occurred because the original data never changed.
“Smart Objects” can be resized, rotated, etc. many times Non-Destructively!
Parametric adjustments to the file are reflected when the image is displayed but
only get applied (rasterized) when the file is output.
Try to maintain Parametric Image Editing [P.I.E.] throughout the digital
process – or as long as possible. The original raw data in a “Smart Object” goes
as far back as when it was initially captured in the camera.
Remember, digital software will continue to evolve. When it does, we can
apply those additional software capabilities to the original raw data we captured
years ago!
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The Big Picture: The Photoshop Handshake
If you have the Adobe Photographer’s subscription and use both Lightroom
and Photoshop, there are definite advantages opening your files in Photoshop
(PS) from Lightroom (LR). The main reason is, this workflow will keep track of
your edits - opening a file from LR to PS, LR with keep your PS changes. Upon
saving your PS work, LR will update and place your PS file into LR. LR will also
place/stack the PS file beside the original file you open. No lost files!
No “extra” original” PS files… a great tool for supporting the “One Master”
workflow.
There are two considerations when you open a file from LR to PS.
1. Setting preference as to the formatting of the PS when opened
2. how you will open the file(s) in PS.
Setting PS File Preferences in LR
In the LR “Preferences” under the “External Editing” tab you will choose the File
Format; Color Space; Bit Depth Resolution and Compression. You can see
my choices in the inset – (here we are just

talking about our options - there will be more
discussion later in this book)

- TIF or PSD (Photo Shop Document) -your
choice – I choose TIF because I started
using TIFF before PSD was created – it’s a
habit!
- ProPhoto: because it is the largest color
space available to us… and we want to
process in the largest color space – right
- 8 bit/16 bit: – your choice –16 bits create
file size 2x as large and, if I keep my data in Raw [P.I.E], I can make that
8/16-bit choice later
- Resolution 240 (PPI)… you can set what you want here – some feel more
comfortable to set it to 300. It doesn’t affect file resolution, just document
sized based online resolution of the file.
- Compression: “None” because it saves files faster and storage on drives are
cheap –our time isn’t.
Enough for now, let’s talk about our option when opening files in
Photoshop with these preferences.
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Option When Opening File from LR into and External Editor
Your options are to: “Edit in…” PS; Other Apps; Open as Smart Objects;
Merge to Panorama in PS; Merge to HDR in PS; Open as Layers… oh,
really now. What are all these choices, I just want to get working to
make PS edits.
Let me go down this list:

• “Edit in…” Photoshop - the standard but, you could have choices…
o If you are opening a .jpg (ugh) or Raw file, LR will open the file directly into
PS and raster it into pixels… we just
entered the world of destructive editing
Ugh!/Ugh!
o If, however you are opening an edited
(TIF or PSD) file, you’ll be prompted to
choose from 3 choices
 Edit Original; Edit a Copy; Edit a
Copy with LR Adjustment… you can
read the descriptions, but you will
use Edit Original most often. Why? When you opened your raw file
from LR to PS to edit, it was saved as a TIF or PSD (depending on the
preferences you chose earlier). When you are working on an edited
(TIF/PSD) that was saved – you’ll want to reopen the file to continue to
work on it
Other Apps: You can set-up a second External Editor in your preferences
Open as Smart Objects: you should be using this most of the time for reasons
discussed earlier in The Big Picture: Working with Smart Objects & P.I.E.
Merge to Panorama or HDR Pro in Photoshop (Don’t): LR’s Merge is better
Open as Layers: very powerful for creating collage and animation in Photoshop
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The Big Picture: Working with One Master File
In this example, there are two iterations (“children”) of the “Master” file.
Changes to the “Master” (parent) file are reflected in its “children” files.
Master
Children

Which One Do You Like!
Here is a wonderfully bright and colorful Floridian scene. In Photoshop, I
cleaned up some scratches on the “Jag” and removes some wires and yellow
lines on the pavement. When I gave the photo to my brother, he showed me a
B&W Polaroid he had of the car taken when new in 1965. It got me thinking
about making a black & white iteration of the photo… the middle image.
Then I wondered, what would it look like with an infra-red iteration on his
red-Jag? Both B&W iterations were really good… matter of fact, all 3 – the
master and 2 iteration worked for me.
By way of demonstrating the power of having One Master file with
“children” (virtual copies), I created the example above. Notice the 2nd row. I
removed the 4th (rightmost) window on the Master File… the change was
reflected in the two “children” files.
More Than Just Cool!
Ever remove a “zit” from someone’s face? Or an exiled brother-in-law from a
wedding photo? … only to have it show up in a photo at a reunion 10 years later
because… you printed the wrong file!
Or created separate files for different print sizes… and then sent the 5x7 file
to be printed on a 16 x20 print. Yeah, me too – the print was soft AND the face
had a “zit” and my brother in law was in the picture. Saving several iterations in
different files is so “early millennium!
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The PhotoCycleTM
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The PhotoCycleTM

When I started writing this book, my main intent was, of course, to discuss the
4 Phases of Digital Image Processing. They were very easy to identify:
1 - Convert

2 - Global

3 - Selective

4 - Expressive

Phase 1-Convert: changing captured digits to software dots – a photo
Phase 2-Global: multiple global scene adjustments that effect every part
of the captured data
Phase 3-Selective : adjustments to selective areas of the image capture data
Phase 4- Expressive: adjustments made to make the expressive photograph
But Wait, There’s More…
It became apparent to me very soon that processing the digital image cannot
occur until you “take a picture” or “capture an image”.
There needed to be a step before the 4 phases of processing - capturing the
image. The diagram to the
The Digital PhotoCycleTM
right represents the
PhotoCycleTM
showing the 4 phases
of digital processing
plus a Phase 0-Capture.
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The PhotoCycleTM.PDF

I created a one-page PDF document that details the current steps for each phase
of the PhotoCycleTM. This PDF is purposely not protected so you can make your
personal notes within the document.
Along with each detailed panel of the 4 Phases, there are several other
panels with other considerations when processing the digital image.
Note:

This PhotoCycleTM document is a detailed workflow to processing the digital image.
The next two pages have the full document.
Here is the link to download the PDF from the book’s website:
Click Here to Download the PhotoCycleTM

[Sidebar]

There is no doubt that in the future new features of digital processing
software will emerge.
The PhotoCycleTM is a living/breathing
document – I will continually update
and repost those changes to the
website.
In the top-right of the page is the date
it was last updated (e.g. 6.13.19).
Please keep checking with the book’s
website to stay current.
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The 4-Phases
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The 4 Phases: Processing the Digital Image
1 - Convert

2 - Global

3 - Selective

4 - Expressive

This chapter will illustrate the 4-Phases of Processing the Digital Image.
There will be many examples demonstrating processing techniques. It is possible
that some of the subtle adjustments may be hard to distinguish in book form.
Remember the book’s complementary web site where examples from the
book will be available to view: www.ProcessingtheDigitalImage.com...
…from the main menu select “Book Photos” then select the section where the
examples you want to view reside.
How To Use The “Globe” Icon
• clicking the “globe” icon on the Title Page of each Phase
o will direct you to the website showing all examples in that Phase
• In the Photoshop for Photographers’ section,
o clicking the “globe” icon associated to a specific example …
will take you to that specific example on the website
“Submitted Photos”
You’ll find photos submitted by readers under “Submitted Photos”. Again,
you are invited to send your photos processed using the 4-Phases Workflow.
Please share your thoughts and questions at the bottom of this webpage.

Let’s begin to explore the 4-Phases of Processing the Digital Image.
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Phase 1… Convert

[Phase 1] “Convert”…” Digits to Dots”

PhotoCycleTM

• Set “Camera-specific” Defaults
Constants settings used for EVERY image
o Lens Correction
o Sharpness and Noise Reduction
o Create Custom “Camera Color Profile”
Note: “Defaults” are set by:
> software - if shooting Raw
> camera - if shooting JPG
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Phase 1: Convert

Here, the software converts the camera’s digits to dots (D2D) to form a picture.
“Hey, but I don’t Process my images – I just take photos with my point-andshoot camera or my Camera-Phone.”.
Now for those of you who don’t think you process your photos, because you
don’t use a computer, make no mistake – processing occurs - and plenty of it!
This processing occurs in your camera or Camera-Phone. How your image is
processed is determined by the camera
manufacture’s default develop settings.
You may be aware of some settings –
exposure, contrast, white balance, and
maybe not aware of others: color
saturation, sharpening, noise reduction;
lens correction; chromatic aberration
removal, etc. I’m sure there are many
more that I am not aware of.
These processing adjustments are applied to each image, and if not specified,
are saved in an industry standard JPEG file format.
What looks very innocent and seems straightforward – pointing your camera
at a scene and immediately seeing the scene displayed as a picture on the back
of your camera – is surprisingly complex. Minor changes in voltage on your
camera’s photosensor, representing scene’s brightness from shadows to
highlights, are used to create a photo.
These miniscule changes of voltage need
significant processing to make an
acceptable image.
Remember my statement earlier that
90% of your image is created by the
software! Let’s take a closer look at this
convert phase.

[Camera Preview]

The preview that you see on the back of your camera’s viewfinder is processed
with the manufacturer’s defaults settings. What you are seeing is a JPG
representation of the 1s&0s captured. For those of you who religiously live by
the “Blinkys” on the back of your camera to evaluate exposure, you should
know, especially if you shoot raw, the image displayed is limited and pretty
useless. The purpose of peeking at the camera preview (called “chimping”) is to
check composition and see if your grandchild is smiling.
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A Word About Histograms

The histogram is often misunderstood. Some think the histogram defines
what the image should look like… quite the contrary. The histogram just
represents the dispersion of brightness in the file.
A histogram of a black cat would have many of the pixels
to the left side.

Although quite different, a proper representative
histogram of a white rabbit would be to have many of the
pixels on the right side of the histogram.
When you photograph a gray card, your histogram will
have a very thin line in the middle! Why? Because the
dispersion of 100% of the pixels have same
mid-brightness.

Software Develop Defaults

Beyond the necessary conversion of these small voltage changes on the
camera’s sensor, there are many additional settings you can apply to every
photo… your default develop settings.
Many software programs allow you to set the Default Develop Settings.
“What processing settings should
you set?” The answer, “the settings
that are applied to every image
capture brought into your software!
Many software programs allow
these settings to include the specific
camera profile of the captured the
image!
Let me state this another way, if
you had 3 cameras and one camera
card, you could use that one card in all
3 cameras. Providing the software had
camera-specific profile set in develop
defaults for each camera, the software
would recognize which camera took the
photo and apply the correct camera defaults!
You might say, “If I set the same default to all my camera, what does it
matter?” If your default settings include a camera-specific color profile*, then
two wedding photographers could shoot the same wedding and the maid of
honor’s teal dress would be the same color when processed in your software.
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What Default Develop Settings Do We Need for Every Photo?
You need to give some thought as to what settings you would want for every
image capture.
Every scene is unique – its own exposure, contrast, brightness, dynamic
range, etc... Therefore, each scene needs its own specific basics adjustments,
so, you do NOT want any basic scene adjustments in your default.
What settings are common to all exposures? Here are my suggestions
Default Develop Settings:

Note: This screen is Adobe Lightroom’s “Create Preset” screen. I am using it to
show all possible choices when setting your “Develop Defaults”. (See Appendix D)

About the “Treatment & Profile” Area… this is very powerful
• If you select nothing, the software will use the manufacture’s color default.
• If you select something, they expect to you to add a profile such as:
o emulating a camera manufacturer’s profile: e.g. “Camera Faithful”, or
o an Adobe creative profile such as “B&W 01” or “Artistic 07”
Other than the manufacture’s default, these profiles would not be applied to
every image capture and therefor would not be used as a default.
However, this is where it gets powerful. The software can add a custom
profile, such as a “Camera Calibration” specific to your camera(s) and apply it
to every image captured by that camera!
I strongly suggest you calibrate your camera(s) and include this “Camera
Calibration” to your Default Develop Settings.

…Let’s talk more about creating and using a camera calibration profile
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Creating and Using a Camera Calibration Profile

A camera-calibration profile defines the “personality” of your camera
sensor… its color bias, contrast, dynamic Range, etc.
If you are interested in color fidelity – this step is a must for you. Create a
specific color profile for each camera you have. An easy way to do this is using
an X-Rite ColorChecker.
Simply photograph the ColorChecker and then
open the file with the provided software. The
software knows the colors of the ColorChecker and
compares them to the colors produced by your
camera. It creates a custom camera calibration
(Xrite ColorChecker Passport
profile, a Lookup Table, removing the bias of your
camera’s sensor.
Add Your Specific “Camera Calibration” To Your Develop Defaults
While processing an image, reset all default settings to your image. Now, in
the “Profile” area, select your newly created “camera calibration”. Now re-save
your Default Develop Settings. When importing files into your software, this
Camera Calibration, along with all your other Default Develop Settings are
applied when converting digits to dots.
There Is More?...
The camera’s sensor responds differently under varied lighting conditions –
outdoor vs. indoor. The X-Rite Passport software mentioned above can create a
dual-illuminant camera-specific profile. To create this dual-illuminant profile,
shoot the ColorChecker target twice, once in daylight and once indoors. Using
their software, select the 2 exposure and it will create one profile with two
illuminant lookup tables: Daylight & Tungsten.
When you convert digits to dots, your processing software will use the dual
lookup tables and mix the appropriate illuminant throughout a wide range of
color temperatures for the various lighting conditions specific to that scene.
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Applied Develop Settings
Did I say before how smart these digital processing software are? They not
only recognize the camera body that the photo was captured with, they can also
detect the lens used during capture!
Some processing software manufacturers provide lookup tables (LUTs) for
the most popular lenses. These lens profiles have corrections for lens vignetting,
distortion and chromatic aberrations!
And yes, provided you checked the lens correction box when creating your
Default Develop Settings, these lens corrections will be applied when importing
files into your software… look Ma, no hands!
Default Develop Setting

Lens Profile Correction
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…More Default Develop Setting Comparisons
Camera Calibration Correction

====================
Default Develop Setting

Sharpening

No Sharpening

Aggressive Sharpening
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Phase 2: Global

[Phase 2] “Global”

(Adjustments beyond standard Camera defaults)

• “AutoTone” (Color/B&W)

…“Intelligent”/Adaptive Technology

=========================================

 Exposure or White Balance or Crop*
*(effects AutoTone)

PhotoCycle

TM

In Phase 2, we apply
adjustments that are
applied to the entire
image.

 Contrast; Highlights; Shadows;
White & Black points
• Other “Basic” Considerations:
o Texture; Clarity; Dehaze
o Vibrance; Saturation
• More Considerations:
o Tone Curve –Global (basic)
o Sharpness and Noise Reduction
 Texture; Clarity; Detail interplay

o Lens Correction
o Transform
 Auto; “Guided”
 Manual:
• Aspect Ratio; Scale
o Vignette “Globally” (post crop)
o Profile: Camera Specific (or “Default”)
o Crop Aspect Ratios: Standard?
Other?
o Treatment (Color or B&W)

Page 45

The 4 Phases

Phase 2-Global

Phase 2: Global Intro

You can try very hard to apply global adjustments to satisfy every part of the
photo. No matter how hard you try…given the nature of light and shadows, this
is pretty much an impossible task.
What’s Our Goal During this Phase? To make the best global adjustments that
satisfy most of the captured image. We’ll need the next phase of digital
processing to address those specific areas that need selective adjustments.
Where Do We Start? If your software supports it, the first adjustment is to apply
an “auto” tonal adjustment. Here is where the software, some better than
others, will analyze the data in the image capture and present you with an
optimization of that scene’s captured data.
Optimizing Your Captured Data with Adaptive Technology
When processing a photo for optimum adjustments, many software have a
preference for the order of using sliders. Adobe’s Camera Raw (ACR) software
optimize processing using the sliders “top-down”. No matter how many times I
try to process in this manner, I always end up with a satisfactory result before
touching all the sliders – always wondering if I obtained optimum processing.
Adobe’s AutoTone” applies its adaptive processing technology from the “top
down”. Because of this, my first adjustment is always “Auto Tone”. Although
“AutoTone” rarely produces the final results - I feel comfortable that my image
is processed optimally. From here, I proceed in a “touchy-feely” manner by
looking at the screen while adjusting the sliders… I suggest you do the same.

A Word About “AutoTone”

The more advanced software use “adaptive technology”. What this means is
the software programs will make data based on the data it sees in the captured
image. When you then use “AutoTone”, the processing software reshapes its
unique “curve” to optimize the tones throughout the image. It moderates
changes is tonal relationship as well as finds the “black” & “White” points.
As I mentioned in the introduction, unlike a roll of photographic film, digital
processing is unique for each digital exposure. And, if you remember, I said that
these “digital curves” can be very unique… “Contrasty” scenes tend to have a
“digital curve” with very abrupt angle changes while a “digital curve” of lower
contrast images tend to have less dramatic angle changes. Here are 2 example
of adaptive technology curves for very different scenes:
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After “AutoTone” - What’s Next?

aspect of the image that needs processing.
This could be exposure; white balance or even cropping*(See examples below).
Once you address the most troubling aspect of your image – what “next”?
…the “next” more troubling aspect that needs processing.
This “next” approach to digital processing continues, addressing the “NEXT”
most troubling or “important” aspect of our image. The “Next” approach
continues until we are satisfied. Because every image is different, the processing
sequence will be different.

When processing, changing “White Balance” or “Cropping” may affect
the overall image. After adjusting either, if a noticeable change occurs
you may want to use “AutoTone” again.

Setting your camera to Auto White Balance [AWB] is probably the
worst thing you can do. A shot of a red rose with a green grass
background compared to a full-frame close-up to the same rose will
produce different color roses! Set you camera’s WB to “Daylight” the
adjust your final WB when processing.
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White Balance: In the Camera
I set my camera’s White Balance to Daylight… regardless of the time of day
or being indoors or outdoors.
I have my “white balance” default in my software set to “As Shot”. This gives
me results very much like shooting film. Setting your camera’s WB to “Daylight”
will provide you with a more representative and predictable rendition of the
scene’s color temperature: Shooting at the “magic hour” you’ll get rich warm
tones; shoot later in the day, or in snow and you’ll get those cool blue tones.
White Balance: In the Software
A word about final “white balance”, there is no “correct” white balance – it is
what you feel – or what you felt about the scene. I shoot all my exposures with
the white balance set at
“Daylight” then correct for
white balance, if necessary,
when processing. Simply use
the software’s “White Picker”
and click on a neutral tone in
the photo. In this “Grandfathers”
photo…I clicked on George’s
gray shirt.
In this foggy morning on the Rhone river below… again using the
“White Picker” on the white boat will remove the foggy morning blue
cast and get the boat to neutral. Hmm, both White Balances work –
they just make a different statement…

...or maybe a “white balance”
somewhere in the middle
…it’s your Artistic Expression!
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Merging Photos (Panoramas and High-Density Range Files)

Before continuing to the next phase, we need to discuss merging photo files.
We “Photo Merge” files to produce “Panoramas “and “High Dynamic Range”
[HDR] photos.
Photo merging belongs in Phase 2-Global because after merging multiple
sections of a panorama or multiple exposures into an HDR file, you will have one
resulting file that will need global processing.
Photo Merge: Panoramas

There is no limit to the number of sections (captures) to use when stitching
together a panorama. Also, panoramas do not need to be just in a horizontal
row, you can run 4 pictures left to right then move up a little take 4 more right
to left then move up a little take 4 more left to right. Now run it through your
panorama software and let it work… and voila! – a French cathedral.

Initially, “stitching” panoramas was not so easy. It took lots of pain for good
results - you needed to match exposures, keep the horizon level using a tripod,
use the proper focal length lens, etc. Oh, a galaxy far, far away.
Now, you just need to take multiple overlapping photos… Shoot each
exposure with a minimal of about one third overlap and cover the area you
want in your panorama - that should do it. No calculating exposure, no lining up
horizons, a change in camera tilt - not a problem for today software. The current
state of panorama software will - balance exposure, match horizon lines and
change tilt if necessary - have I mentioned how smart today’s software is?
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A Few Panorama Tips
You should be aware that you will get less distortion if you take twice as
many telephoto (narrow angle) sections… Say 10 telephoto lens sections versus
5 normal focal length sections versus 3 wide-angle sections.
Factually… if I were taking pictures for an architect of their building – I would
take more narrow angle sections for a more accurate rendition – though I’m not
sure I’d use a tripod.
Creatively… the game is on. Case-in-point, the previous 12- panel panorama
example of the cathedral in Bourges, France.
There are many ways to stitch or merge panoramas. You can use Photoshop,
Lightroom or a third-party software. If you have Lightroom - use Lightroom! Its,
processing is advanced and is simple to use.
Select the thumbnail photos to merge for a panorama, right click and select
“Photo Merge”> then “Panorama…” then click the “Merge” button. Lightrooms
panorama will not only
stitch the panels together,
it will detect the camera
tilts, exposures changes
and align the horizon. It
will detect the best
spherical correction and
“autotune” your exposure
- I wonder if it does dishes.
Now here is the best part of the process. Before saving, you’ll the have
choice to remove the white spaces above and below the panorama. You can
crop, so 1990’s, or you can choose
“Boundary Warp” – here is a glimpse of
photography future. The software will fill
the white areas by analyzing neighboring
pixels and intelligently create pixels to fill
to the boundary!
I guess you could explore other
panorama software, but, when you have
the tool that does everything you need…
why look for more!
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“High Dynamic Range” [HDR]

We just discussed the power of Lightroom when making panoramas… Well
it’s even easier with HDR merges.
Select the thumbnail photos to merge for your HDR photo, right click and
select “Photo Merge”> HDR…”
Your options will be “Auto Align”,
“Auto Settings” – check those
boxes. You’ll also have options for
“Deghost Amount”, the degree of
movement between exposures
that it will remove. “Low” ghosting
means you’ll see more blur, “High”
ghosting removes the most. (I use
“High” - unless I want to show blur
from movement between photos.)

There is also a box “Show Deghost
Overlay”- check this if you want to see where the magic happened.
The last box is “Create Stacks”. If this is checked, when you click the “Merge”
button, the software will merge the HDR. Then, when done, it will take the files
used plus the combined HDR files and put them into one stack so you only view
the created HDR.
The hidden gem here is that Lightroom makes a 32-bit file! Not a 16 bit but a
32-bit file. Your “Exposure” slider that had extremes of -5 to +5 stops, now goes
from a -10 to a +10 stops! There’s plenty of processing room in a 32-bit file.
For all those people who want to know if you can do an “HDR Panorama”…
Adobe’s way ahead of us… there is a button for that to.
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A Few HDR Tips
In the example here, I have 7 exposures one-stop apart – my standard. I have
this setting in one of my camera’s custom setting. When I see a dynamic range
situation, I quickly rotate my camera dial to that custom setting, hold down the
shutter release and in less than ½second, I have 7 exposures one-stop apart.
I don’t think much more about the scene - I just go on shooting. Not much
more I can do – I captured a ton of data. I’ll check out the HDR successes when I
get back to Lightroom.
I don’t use all 7 exposures - I think that’s overkill. I usually use exposures
1, 3, 5, & 7 or EV -3, -1, +1, +3. That’s it!

The inset is the same HDR file
adjusted in Lightroom using the
“Transform” - “Auto” setting to
remove perspective distortion.
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Phase 3: Selective

[Phase 3] “Selective”
…It’s all about Selection

PhotoCycleTM
In Phase-3 Selective, we
will apply localized
adjustments that will be
unique to each image.
Here, the photographer’s
sensitivity and
observation of tonal
relationship is critical.

• Selective Tools
o Adjustment Brush
 Density 100% (reduce & repaint)
 Colorize
o Linear and Radial Gradients
• “Shaping” Selective area
o Shape selection “Brush”
o Relative Adjustment
o Range Mask
• “Group” Selective Adjustments
o Crop
o HSL
o “Target Adjustment” tool [TAT]
 HSL (B&W)
 Tone Curve (Advanced)
o Pixel Replacement (Parametric)
 Red-Eye
 Spot Removal/Add
• Merge: Panorama & HDR
• Converting to B&W (using Color data)
o Adjust by color value
 Tone, Auto, Manual
• General:
o “Multiple Ways” to “Reset”
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Phase 3: Selective
It is all about selection… if you can select it, you can affect it!
This is what Phase–3 “Selective” is all about.

How effective we can be here depends on:
1.) our sensitivity to the tonal relationships in the image, and
2.) the ability to select those areas.
Today’s processing software give us powerful tools to do just that –select
areas and adjust tonal relationships. We have many tools. They vary as to how
they select areas, and once selected, how they can affect those areas.
To Paraphrase Ansel Adams:
“Selective Adjustments are steps to take care of mistakes
God made in establishing tonal relationships.”
Power of Multiple Adjustable Attributes:
What makes these Selective tools so powerful is the number of attributes
that can be applied to these “Selected” areas. We need to re-think our
Photoshop experience… where we created a “mask” or ‘selection” for a single
adjustment. We needed to create multiple masks with one adjustment each
instead of the power we have now - to create one selection with multiple
adjustments!
Ponder this new paradigm:
Using multiple tools in one image with the ability to edit then re-edit selected
areas for Exposure; Brightness; Contrast; Saturation; Clarity; Sharpness, Color;
etc.… without loss of image data is unparalleled in photographic processing.

Let’s explore this important phase
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How to View This “Selective” Example

On this page, the left photo shows the results after Phase 1-Convert & the
first step in Phase 2-Global - “Auto Tone” (this is done to every processed photo
before “the next step”). The right photo shows the final processed photo with
multiple “Selective Adjustments” applied.
Phase 1 + “AutoTone”

Final Processed Photo

“Individual-Selective Adjustments”
The next page shows the individual areas adjusted and the tool used.
- The “pin” represents the location of the tool.
- The red area (“mask”) is the “selected area” that is being adjusted.
- The BLUE text is the tool used;
(see below)

A.) Radial gradient – toning down; lowering contrast and desaturating edges
gradually. Then, erasing the mask (effect) in the lower-left while shaping
the gradient around the subject.
B.) Adjustment Brush lowering contrast while bringing edge clarity and
raising exposure all to lighten the leaves and the shadow
C.) Linear Gradient from the upper-right of the photo toning down the
highlight and contrast
D.) is the sum of all the adjustments above
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Raw Capture on iPhone
Shot by window with multiple “Selective Adjustments”
Selective Adjustments:

A. Radial Gradient

- Radial Gradient - selective
vignette
- Brush lower left - lighten plant
- Linear Gradient - Lighten
shadows in upper right

B. Adjustment Brush

C. Linear Gradient

D. Combined Adjustments
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“How to View These “Selective Examples”
These examples are presented in 3 panels:
1. As it was captured - the camera’s metered exposure for the scene.
2. The digitally processed image, and
3. The shaded “mask” used to achieve the processed image.
This “mask” is made with multiple tools as the previous example. The
“mask” you see is a composite of all the tools used in the adjustment.
In the Description Box:
Is the title;

; and their effect in Blue.

Selective Adjustment: “Description Goes Here”
- Explanation of desired effect: Tool(s) used select adjustment area
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Selective Adjustment: Harsh Light

Selective Adjustment: Harsh Light
- Lighten lower left corner - Selected with linear Gradient
- Lightened Body Shadows: multiple Brushes, brush w/multiple densities
o multiple brushes of various density to lighten body shadows using
“Exposure”
- Increase detail in dark areas: Selected with Brush
o using friendly pairs: Contrast /Clarity
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Selective Adjustment: Keys’ Bikes

Selective Adjustment: Vivid Floridian Light & Color
- Saturate yellow wall: Selected w/Target Adjustment Tool [TAT]
- Open shadows on shutter: w/Brush Exposure / Shadow
o adjustments “Shadow” slider;
o Friendly Pairs: Contrast / Clarity
o Saturate Green shutters with TAT.
- Removed “grate”: with pixel replacement
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Selective Adjustment: Yellow-Hat Lady

Selective Adjustment: Yellow-Hat Lady
- Lighten left side of face: Brush w/ Exposure & Contrast
- Darkened right side of face: Brush w/ Highlight / Whites / Exposure
- Blurred, lowered Contrast & Saturation of background. Radial gradient
- Shaped Edge Vignette: Radial gradient
- Lightened & brightened strawberries: Brush w/Exposure / Saturation
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Selective Adjustment: P-Town Breakfast

Selective Adjustment: P-town Breakfast
- Lighten many shadow areas with one brush at various densities
- Windows toned down: Brush w/ Exposure / Contrast /Whites
- White towel on counter: Brush w/ Exposure / Contrast
- Lowered contrast & brightness of light on left to balance room light:
Linear Gradient w/ Highlight / Exposure / Contrast / Whites
- Lightened & Shaped cook: Brush w/ Shadows / Exposure
using “Friendly Pairs” Contrast / Clarity
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Selective Adjustment: Snap Peas

Selective Adjustment: Snap Peas
- Cloned Peas to fill bottom left w/Clone tool
- sharpened & enhanced depth to pod: Brush w/ Sharpen / Texture
- Blurred, lowered Contrast & Saturation of background. Radial gradient
- Shaped Edge Vignette: Radial gradient
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Selective Adjustment: The Eiffel Mask
The emergence of artificial intelligence [AI] in our processing software
provides us with more magical tools. Creating a detailed mask for the Eiffel
Tower could be tricky, but thanks to AI we can accomplish this with one slider
quite easily.

Selective Adjustment: The Eiffel Mask
- Create a rough selection covering the entire tower: Adjustment Brush
- At the bottom of the adjustment tool, add a “Range Mask” and select an
attribute: in this case, “luminance” [Inset 1]
- Contract the “luminance range” by moving the markers at each end of
the sliders… Raise the black point and lower the white point to adjust the
mask – you will see the mask trim in real time.
o Adjusting the “Smoothness” slider will refine (tighten/expand)
the mask. [Inset 2]

[Inset 1]
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Pixel Replacement: Azorean Aqueduct w/ Family & Unknown Woman in Red
Visiting this Azorean aqueduct provided a great family photo-op. When
editing the trip’s photos, I noticed a stranger in red. Here is where a creative use
of the “Clone Tool” remedied the situation and removed the stranger in red.

Original Capture

Removed stranger woman in red

Cloned little girl in lower right
to middle of trail

Replaced little girl on lower
right with grass

Leveled aqueduct wall causing
little girl’s position to bottom

Repositioned girl to end of trail.
Final Processed Image
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Selective Adjustment: Hannah and the Target Adjustment Tool

Selective Adjustment: Hannah
- Changed green dress to purple: w/Target Adjustment Tool/Hue:

Selective Adjustment: Hannah
- Added sky backdrop using “pixel
replacement”:
1. Opened photo from Lightroom
into Photoshop as a “Smart
object”
2. Opened “sky” photo and
placed layer under little girl’s
“Smart Object” layer
3. “Selected” the background
behind the little girl and
created a mask to reveal “sky”
backdrop
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“Friendly Pairs”

In the PhotoCycleTM there is a panel titled “Friendly Pairs”. The adjustment in
this panel are sliders that interplay nicely with each other.
That is, they complement each other and are usually
applied when refining in Phase 3 Selective. These are best
applied using masked selective tools.
Friendly Pairs: Contrast/Clarity (*see Frequency)

Less “Contrast” brings out detail but causes “flat” tones. When adding
“Clarity”, we add edge sharpness that adds contrast while maintain detail from
lowering “Contrast” … a great technique for bringing out detail in the
foreground of a sunset, a black crow in a tree, a black tuxedo.

Gradient Tool
w/Luminance Range Mask

lower Contrast

add Clarity
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Friendly Pairs: Shadows/Black Point

Move the “Blacks” slider to find the photo’s “black-point”. Now, move the
“Shadows” slider up aggressively to reveal shadow detail. This may need to be
repeated several times to hone-in on the final adjustments:
o aggressive shadow detail may move the black
point so keep checking the black point.
o Depending on the frequency of the subject,
adding some edge sharpening could bring out
more detail.
Gradient Tool
w/Luminance Range Mask
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Friendly Pairs: Highlights/ White Point

To bring out more detail in the bright areas, use the friendly pairs of
“Highlights” and “Whites …
o lower the “Highlights” slider while raising the “Whites”
Again, it is a good idea to add these adjustments
to a selective tool with a refines mask.

Brush Tool
w/Luminance Range Mask

lower “Highlights” ; raise Whites
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Friendly Pairs: Sharpness and Noise Reduction

The combination of Sharpness and Noise Reduction will help you remove
noise from your photos. This is especially useful when trying to remove lots of
noise from ISO 6,400 and higher. The concept of using these friendly pairs is to:
o Aggressively over sharpen – see white “crystalize” edges on objects, then
o use the Luminance (softening) slider to round-offs the edge effect of over
sharpening.
o Radius and Color sliders can further improve in noise reduction…
Most of my knowledge (plus years of application) come from the readings of
Jeff Schewe’s book, The Digital Negative. I can’t recommend this book enough.

3x Magnification
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Frequency

There are several adjustment sliders: Clarity; Texture; Dehaze, that are
mistaken for being mid-tone contrast adjustments… they are not. They are
based on edge contrast – very similar to the Sharpen slider. Matter of fact, you
can add Texture; Clarity; Dehaze; to the “Sharpen” family of sliders.
To quote John Paul Caponigro: [link to his article - click here]
The differences between these tools can be found in the way they handle
frequencies of detail; low, moderate high fine lines texture, and grain.

Frequency is an important part of sharpening and edge contrast.
The same amount of adjustment for any one of these sliders from the
“Sharpen” family will have a different result depending on the frequency of the
edges – a.k.a. “texture”.
A good example would be a door that is half glass and half screen. There is no
texture frequency to the glass portion but there is a lot of texture frequency on
the screen portion. Applying a global adjustment to the door, in this case
“Sharpening”, will result in two different amounts of edge sharpening. (see below)
*

Aggressive Global Sharpening –
effecting mostly screen area.
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Progression of increasing
“edge contrast” tools –
from none to most

1-Curves

2-Clarity

3-Dehaze

4-Texture

5-Sharpness
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You need to approach Photoshop in a similar manner. There are graphic
designers who use Bezier curves, design fonts, move object-oriented elements in
to Adobe Illustrator; …and so on, and so on, and so on!
If we stay in our “photographic domain”, there may be a possibility to not
get overwhelmed by Photoshop. There are just a few important features a
photographer needs to understand – maybe 3% of Photoshop is for
Photographers! If you tried unsuccessfully or have been holding back to take
the Photoshop plunge, hopefully after reading this section you’ll take that extra
step and give Photoshop a(nother) try.
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The 4-Phases

Phase 4: Expressive

[Phase 4] “Expressive”
…Production Tips & Techniques

PhotoCycleTM
In Phase-4 Expressive,
we refine our photo in
the hopes of expressing
our “Artist’s Vision”.

Lightroom [P.I.E.]
• Histogram “Lab”
• Localized Noise Reduction
• History State
o change before and after history
Photoshop [P.I.E.]
…“Photoshop for Photographers”
• LR /PS Handshake (P.I.E.)
• Layers:
o Smart Objects (P.I.E.*) vs. Pixel

* maintain P.I.E. (original data) … as long as
possible

o Smart Filters & Plugins
o Layer Masks (Selection)
o Adjustment Layers
• Pixel Replacement
o Stamp/Clone (Current & Below)
o Copy/Cover/Reveal
• Selection
• Content Aware
o Scale, Fill, Move

* Work in the largest color space: “ProPhoto
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Phase 4: Expressive: Pixel Editing Software
Phase-4 Expressive, is where we will further refine your
photo in the hopes of expressing your “Artist’s Vision”.

Pixel Replacement
One of the most important, and fun features is “pixel replacement”. You
know what I mean, removing telephone wires, a hydrant, superfluous or
distracting elements… all with the goal of enhancing the photo.
Sometime the pixel replacement is out of necessity; sometimes it’s for
creative expression: adding a flock of geese; replacing a cloud structure to
better fit around our building; masking the main subject and placing it on a
totally different background.
This phase can be broken into 2 discrete sections…
1) Simple non-destructive [P.I.E.] processing and
2) more advanced pixel-editing processing techniques
A pixel-editing software is essential when processing the digital image…
…Photoshop is the ultimate pixel editing software.
A Word on Photoshop
Many have has taken a stab at learning Photoshop. At first blush it seems
overwhelming. After the 2nd, 3rd and maybe
4th, try… it not only still seems overwhelming,
it seems nearly impossible to conquer.
I know, I’ve taught many Photoshop courses –
I’ve seen the befuddled look on 90% of the
class. The other 10% were either smart and
got it… or, didn’t know they weren’t getting it!
I like to make a parallel to those of us who use Microsoft’s Excel spreadsheet
program. If you ask somebody if they know Excel, they say, “Oh yeah, I use it all
the time at work”. Excuse me, take a deeper look into Excel… Nobody, nobody,
nobody knows all of Excel. Some may know financial equations, others scientific
functions, while most of us use simple mathematic relationships of one cell to
another… But nobody, I say nobody understands all of Excel.
Photoshop is as complex as Excel! Graphic designers use Bezier curves, redesign fonts, move object elements into Adobe Illustrator; etc. However, if we
stay in our “photographic domain”, there may be a possibility to not get
overwhelmed by Photoshop. There are just a few important tools a photographer
needs to understand – maybe 3% of Photoshop is for Photographers!
If you’ve tried unsuccessfully or have been holding back to take the
Photoshop plunge, hopefully after reading this section you’ll take that extra step
and give Photoshop a/another try.
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Photoshop Basic Examples

All the following examples start after the first three Phase of processing the
digital image. All examples followed the PhotoCycleTM workflow from:
0-Capture… defining the scene with 1s & 0s and saved in camera raw format;
1-Convert… processing on import has been set when we established our
camera develop defaults settings;
Phases 2- Global & 3-Selective… have been completed with craft and
creative awareness adjusting the scene’s tonal relationships.
It is now time for Phase 4-Expressive.

Although the expressive phase can use both camera raw and Photoshop
processing – these examples will show how using Basic Photoshop techniques
can quickly get us to our expressive photograph.

“How to View These Photoshop “Basic Examples”

Each example has a title and description. The description explains the scene
as it was captured and the Artist’s Vision on how the Photoshop work could
remedy the photographer’s issue… Phase 4-Expressive.
These examples are presented in 3 panels:
- The 1st panel shows the digitally processed image photo through the 1st 3
Phases of the processing PhotoCycleTM, and before any Photoshop work.
- The 2nd panel is after Photoshop work
- The 3rd panel shows Photoshop’s “Layers Palette” with the layer(s) that
altered the image.
Let’s begin with some fun and Easy aspects of
Phase 4-Expressive using Photoshop
A Note on This Book’s Photoshop Examples
These examples are not intended to be a tutorial for learning Photoshop, but:
- to see how photographers continue their artistic expression using this
powerful pixel editing tool;
- to understand the importance of a pixel-based editor to the digital
photographer when processing the digital image.
The first set of examples show some basic Photoshop processing that go
beyond the scope of most camera-raw software. The second set second of
examples will use some relevant “Photoshop for Photographers” processing
tools. (A list of the Photoshop tools essential to the digital photographer are listed

at the end of this chapter.)
Some of these enhancements can be done quickly, others - Not so much!
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Pixel Replacement

Jaguar XKE [Note the wires over the building behind his right elbow]
Beautiful Florida day, beautiful prime colors, beautiful white fleecy clouds…
and a not-so-beautiful pole and wire in front of the cloud…and maybe
remove some scratches on the side panel and yellow parking lines.
Here are the Photoshop layers used:
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Photo of Trumpeter [Not the person behind his right elbow]

A wonderful "Mariachi band" playing for my San Antonio “family” in a small
Mexican restaurant. Lots of patrons crammed in… unfortunately one was
sitting behind the right arm of my great trumpeter shot!
Here are the Photoshop layers used:
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Easter Pie [and other not-so-desirable stuff]
An Italian Easter tradition - Ricotta-Rice Pie. Looked so good I wanted to
photograph it. It was during editing that I saw: 1) my glasses lower-right;
2) edge of counter_ lower-left; 3) the blue saltshaker upper-left…
… and was the color of that cup red or green?
Here are the Photoshop layers used:

I changed the hue of the red cup
to green in camera raw using the
target adjustment tool.
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Renoir’s Hydrant
Ok, I wouldn’t have painted the hydrant in either!
He had the choice to paint what he wanted to show us – Using Photoshop, I
also have the choice as to what I want to show!
…after all, this is not Photo-Journalism – It’s art!
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Pixel Adding!!!

Nice Gulls [when they were there]
Evening sunset at Boston’s Waterfront. Beautiful scene as boats and gulls
moved past… not, however on the same timeline. After some adjustments in
camera raw - brightening the scene and adjusting the White Balance… it was
time to add the gulls in Photoshop!
Adding a soft white vignette around the scene gave it a nice finish.
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Collaging

Post Cards from France
Collages are easy and fun to do. Just open the photos you want to collage in
separate photoshop layers – [Hint] convert each layer to a “Smart Object”.
You can then size and rotate each layer many times without any loss of data
until you are satisfied with their final position.
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The 4 Phases

Photoshop for Photographers

The 4-Phases

Phase 4: Expressive

Photoshop for Photographers
[Phase 4] “Expressive”
…Production Tips & Techniques

PhotoCycleTM
In this section we
continue to refine our
photo using Photoshop
techniques for
Photographers

Lightroom [P.I.E.]
• Histogram “Lab”
• Localized Noise Reduction
• History State
o change before and after history
Photoshop [P.I.E.]
…“Photoshop for Photographers”
• LR /PS Handshake (P.I.E.)
• Layers:
o Smart Objects (P.I.E.*) vs. Pixel
* maintain P.I.E. (original data)
… as long as possible

o Smart Filters & Plugins
o Layer Masks (Selection)
o Adjustment Layers
• Pixel Replacement
o Stamp/Clone (Current & Below)
o Copy/Cover/Reveal
• Selection
• Content Aware
o Scale, Fill, Move
* Work in the largest color space: “ProPhoto
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“Photoshop for Photographers”
The examples in this “Photoshop for Photographers” section will
demonstrate more Advanced Photoshop techniques. Again, all examples start
after the first 3 Phases of processing the digital image.
At the beginning of this Phase 4 section, I stated you DO NOT need to learn
all of Photoshop… you probably only need to know about 3% of it!
There are a few important Photoshop tools the photographer needs to
know. I teach a course called “Photoshop for Photographers”. If we stay within
our “photographic domain”, there a good a possibility to not get overwhelmed.
Here, I will address some of the more relevant Photoshop for Photographers tools.
Photoshop for Photographers

Below is a list of Essential Photoshop Tools a Photographer needs to know.
Basic
o Pixel Replacement
- Resize: Image/Canvas
- Copy pixels to new layer
o Layer
- Pixel laver vs. Smart Object
Layer
- change “layer” order
- Layer Mask
- Layer Opacity
- Clone new Layer Via Copy
o Selection
o
o Transform
o Clone/Stamp tool;
- Current and Below
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Advanced
o Content Aware– Fill; Scale
o Masking
o Selection Tools
- Refine Masks:
o Smart Object
o Filters:
- Smart Filter
o Plug-ins
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How to View These “Photoshop for Photographers” Examples

Each example has a title and description. The description explains the
photographic situation. The awareness as to, what was happening around me
and trying to capture that feeling – “Pre-Visualization”
Then observing my feelings when editing “the shoot” and processing the
“selected images” through each phase of the 4-Phases… “Post-Visualization”.
Then, ultimately trying to achieve the Pre/Post -Visualization to help me
make the expressive photograph.
1. The examples start after Phase 3 was completed.
2. The photos before the description are the moment of capture, and after
Photoshop work.
3. The small panels are the Photoshop “Layers” palette showing its effect
4. The text box is an explanation of what I was trying to accomplish.
a. the color of box indicated the degree of difficulty in Photoshop.
EASY

MODERATE

DIFFICULT

What follows are 6 examples using the photographers’ essential Photoshop
tools. I will dissect each Photoshops/pixel editor steps to obtain my Artist’s
Vision. I call this dissection, the “Anatomy of an ImageTM” [AOI]. My intent is to
keep adding these AOIs to this book’s website.
Let’s jump in to Phase 4-Expressive by exploring some
“Photoshop for Photographers” tools.
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AOI: PEM Girl

Artist’s Vision
Moment of Capture

I love this photograph – felt the excitement at the moment of capture. While
photographing in the oldest room of the Peabody Essex Museum. This young girl
was just pondering, looking out these 200-year-old distorted glass windows.
Didn’t have to be much of a photographer to notice the scene… All I could
think of was, “Please sweetheart, don’t move.” She didn’t, and I got this picture.
Unfortunately, I got some confusing elements: a ½ Windows on the right;
don’t know what on the left wall. If you look closely, I cut off the top of the
arched windows. I never noticed the dumpster in the left window, the
construction in the right window; the tilt of the composition, etc.
The moment was right, the other visually confusing elements was not sloppy
photography, just an excited photographer trying to capture the moment. There
was a lot of clean-up to do. To me, this photograph was worth the effort to try
and make a photograph:
- Level and crop-out the extra half window on the right
- remove the clutter on the left wall
- replace the construction outside the rightmost window
…this all took minutes
- Building the curved arches over the windows pixels bit by pixels bit…
…Not so much!
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Photoshop for Photographers
Photoshop for Photographers:

Cloning

Expanded canvas top & bottom
to allow room above to “build”
arches and below to extend floor
and balanced composition
> Resize: Image/Canvas

Added floor by cloning existing
floor then stretching it to reach
bottom of canvas – EASY!
> Copy pixels to new layer &
Transform

“Built” arches above using “clone
tool” to grab like pixel chunks
from existing wall and arches
> Clone/Stamp tool; clone
“Current and Below”

Fixed clutter on left wall.
Stretched pixel from edge of
fireplace to left border; then
cloned small groups of pixels to
new layers above

> Free Transform; Clone/Stamp

Remove outside clutter behind
windows 1 & 4. Used
“copy/mat/revel” technique
clone adjacent panes of glass to
mat dumpster (left) and
scaffolding (right)
> “copy/mat/revel”
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AOI: Family and “Strangers?”

While visiting the
Great Sand Dunes
National Park near
Alamosa Colorado, I
stopped to take a
photo of my son-inlaw, his girlfriend
and… and, 2 other
people sitting on the
sand dunes that I did
not know!
The Photographer’s Task

…to remove the strangers.

This is easily done using
“Content Aware – Fill”. Just
circle the area you want to
remove, and this tool uses
Artificial Intelligence to find
similar pixels in the photo.
It then blends the pixels in the
area you selected!
After pausing for a second to absorb what this remarkable tool just did, I
now had a void in my 16:9 aspect ratio composition. I needed to remove some
of that empty space created by removing the two people.
Again, easily done using “Content Aware – Scale”. This artificial intelligence
feature allows you to disproportionally scale from any side to change the aspect
ratio without “distorting” my son-in-law and his girlfriend! (in this case I moved
the right border in until I obtained a 35mm/2:3 aspect ratio)

[ Sidebar] Content Aware “Scale”
Photoshop analyzed the pixels and scaled areas with similar pixel while notscaling dissimilar pixels - my son-in-law, his girlfriend. Notice the two photos
above with different aspect ratio BUT no distortion of the figures.
Photoshop has many types of “Content Aware” tools: Fill; Patch; Move; Extend; Scale
[Click Here] for a video to better understand this powerful feature.
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Photoshop for Photographers:

AOI: Family and “Strangers?”

Content Aware

> Selection; Content Aware – Fill; Clone/Stamp tool

> Selection; Content Aware – Fill;
Clone/Stamp tool
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AOI: Wispy Wrap

While riding in the back of
a convertible gazing skyward, I
saw these wispy clouds resting
high in a New England autumn
blue sky.
As we drove, pondering as
I do, I noticed the changing
compositions beneath this
wonderful sky.
Quickly the dormers of a classic New England house enter my contemplative gaze.
Quickly I shot a burst of images - 5 captures: two wasted, one capture too much
house and trees; another had a good house size; and the last captured this great
cloud formation… but not one capture where the wispy cloud structure
“wrapped” the house. Again, a simple fix for the Photoshop Photographer…

The Photographer’s Task

Take the house from one capture as the base image. Crop as desired. Then
get the cloud structure from the last capture and place it on a separate
layer behind the house. Finally, move and place the clouds to create that
“wrapping” feeling.
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Photoshop for Photographers
Photoshop for Photographers:

Masking

> Smart Object

> Smart Object; Selection Tools; Masking; Transform

> Smart Object; Transform
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AOI: Cyanotype Friend

My photographer friend Bill Franzen is a pretty unique guy, he’s still
pondering digital processing. An excellent Black and White film photographer,
processor and printer, he gives workshops on making
cyanotype prints.
A group of enthusiastic photographers looked on as
he demonstrated the cyanotype process. After the demo,
Bill leads the group on a photo shoot. Well, this unique
guy went to get his unique camera – a classic wooden
beauty 4 X 5 view-camera.
Documenting the workshop for Bill, I got a shot of
him showing the group how you operate this classic
camera. He loaded a 4x5 film holder, slide it behind the
frosted focusing glass then released the shutter using a cable release amazement abounded!
Viewing my captures in my
“much too modern-day”
camera raw processing
software, I found this
wonderful portrait of Bill.
I thought it might be fun to do
a little something as unique as
Bill – and make a descriptive
portrait.

The Photographer’s Task

Do a little something as
unique as Bill – Maybe make a
distinctive portrait and
incorporate a unique element
for my cyanotype friend.
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Photoshop for Photographers
Photoshop for Photographers:

P.I.E Non-Destructive Processing

> Smart Object

> Smart Object, change “layer” order

> Selection; Layer Mask
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AOI: Fading Flock

Photographing in the
Wakodahatchee Wetlands
near Delray Beach Florida
is a treat. All kinds of
wildlife and vista abound –
great photo opportunities.
The initial review of my
shoot did not disappoint.
However, I came across
this photo “not-so- great”
capture.
But… there was something intriguing about it. The hand, reaching out –
almost as if calling the bird to come. It's not a complete composition but it had
an interesting dynamic. I thought, if only there were more geese as in so many
of my other photos.
I had just viewed a Photoshop video showing some new selection tools. I
thought, maybe getting more birds might work – maybe a flock of geese from
the “one” goose could be a good exercise.
The Photographer’s Task

Build a flock of fading geese from the “one” goose - although fun and
hopefully expressive, I knew this was not going to be quick!
I couldn’t just clone & stamp the same bird shape…there needed to be
some perspective change.
When finished I was quite pleased… definitely a keeper.
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AOI: Fading Flock

Photoshop for Photographers:

Photo Composite

> Clone new Layer Via Copy

> Select; Select & Mask”

> Clone

> Smart Object
> Smart Filter

> Clone
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AOI: Daisy Ladies

What can be more tranquil than this
scene – a field of daisies, two women
talking on a bench, a crowd walking on a
shoreline path, all the necessary elements.
I had nothing specific in mind, just
getting good vibes and soaking in the sun
shooting on a Tuesday afternoon. The
serenity of this wonderful day started me
hearing Spanky and his Gang’s “Lazy Days”
in my head.
When I got to reviewing my shoot, I was right – there were many nice
feelings in this photo, but which was THE feeling? Where was the serenity I felt?

After trying many crops searching for THE feeling, I liked isolating the two
women on the bench. Powerful? Expressive? Serene, my Artist’s Expression?
Well close, BUT, the crowd, the walkers, the path, the rocky shoreline and
the city in the background, the, the, the… well, it’s not too serene. What I saw
while photographing - all this activity, I now see as clutter.
The Photographers Task:

Maybe if I just remove the shoreline and the city; remove that path, the
people, add more daisies – yea, that’s the serenity I felt.
Digital manipulation… Creative enhancements… I like to think it is a visual
expression, a realization of the artistic vision… Just Do It!
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AOI: Daisey Ladies

Photoshop for Photographers:

A Lot of Pixel Replacement

> Clone/Stamp Tool

> Clone/Stamp Tool

> Clone/Stamp Tool

> Clone/Stamp Tool

…
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Photoshop for Photographers

As I said at the beginning of this section, you DO NOT need to learn
all of Photoshop… probably only about 3% of it!
I demonstrated a few of Photoshop’s photographers’ tools. If we stay within
our “photographic domain”, there is a good possibility we won’t get too
overwhelmed. Below is a list of all the tools.
When you think you’re ready, copy the tool from the list and “Google-it!
You’ll get many hits and many video tutorials. I tend to triangulate - I watch 2 or
3 videos then try applying the technique. Don’t spend all your time looking at
every video… we are not librarians… we are photographers!
Too many people on the internet masquerade as instructors. Be careful, after
all, it is the internet. Stick with quality instructors. There are some quality
people sharing solid information: Julienne Kost; Andrew Rodney; Matt
Kloskowski; The Lightroom Queen - Victoria Bampton just to name a few.
Essential Photoshop Tools
Below is a list of Essential Photoshop Tools a Photographer needs to know.
Basic
o Pixel Replacement
- Resize: Image/Canvas
- Copy pixels to new layer
o Layer
- Pixel laver vs. Smart Object
Layer
- change “layer” order
- Layer Mask
- Layer Opacity
- Clone new Layer Via Copy
o Selection
o Transform
o Clone/Stamp tool;
- Current and Below
o Masking

Advanced
o Content Aware– Fill; Scale
o Masking
o Selection Tools
- Refine Masks:
o Smart Object
o Filters:
- Smart Filter
o Plug-ins

x
For a more in-depth discussion of each tool, see Appendix F:
“The Photographer’s Essential Photoshop Tools”
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The Wrap
THE 4-Phases Workflow: Processing the Digital Image

What follows is the signature image of this writing, the [Key Bikes]. I will
take you through the entire 4 Phases PhotoCycleTM workflow. There is a brief
discussion about capturing this image as it effects the 4-phases processing
workflow. Accompanying this complete workflow are examples at each Phase.
“Key Bikes” Observations:
What I saw on the street was not what I captured in the camera. I saw a
recently painted yellow clapboard house in Key West Florida with
a couple of bikes parked in front of the wall.
What I felt was this warm colorful Floridian scene, on a warm
& humid Floridian day – I was envying those bikes in the shade.
Being my 1st visit to Key West, this was the kind of scene that
I imagined many times prior to ever visiting there.
[ Sidebar]: The Backstory
Standing in front of the scene, I “Felt” the Florida Keys yellow, the bikes at
rest in the peaceful cool “shade”. I never noticed the grate on the wall or the
bike’s reflectors and partial seat on the left edge of the photo.
I saw these only after working closely with the photo during the first few
phases of processing. The grate was annoying – it had to be removed! I wasn’t
sure, and still am not 8 years later, if I want to show or remove the reflector
and bicycle seat. Ah, the benefits of non-destructive processing!

0-Capture:
- The captured exposure was +2 stops over camera’s meter reading. My intent
here was not to get the “final” exposure in the
camera but to capture optimum scene data.
- No captured data of the scene exceeded the right
side (highlights) of the histogram.
- The capture was a 12-bit Raw file
[ Sidebar]: “Brightness” of the Capture
Predictably, the capture was not as “bright” as a
+2EV exposure. This under-exposure is consistent
with “subject failure” when metering bright subjects.
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1-Convert:
I imported the file from my camera card to my processing software –
converting the digits to dots. On this conversion, the
software applied my Default Develop Settings including my camera-specific color profile. These
basic default processes are applied to each capture
on import.

2-Global:
My first global step is to always apply an “AutoTone” adjustment.
I then made additional global adjustments to
balance tonal relationship in the photo – as best as
possible… to produce a good general exposure:
• white balance - Slight warming
• Exposure about + 1 stop
• Shadows
[ Sidebar]: Always Applying “AutoTone”
“AutoTone” can be added to your defaults
and be applied during Phase 1-Convert
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3-Selective:
Selective Adjustments made:
• Added yellow to just the clapboard – back to the Floridian-Keys-yellow I “felt”
• Green Shutters
o Target Adjustment Tool: HSL = lighter/greener
o opened the shadows showing more shutter detail
• Bikes
o Brush: + Shadows… lightened shadows
around the bikes’ wheels showing more detail
• Tree:
o Brush: + Exposure; +Shadow; - Contrast; + Clarity
• General: Photo Vignette
o Radial Gradient - shaped a vignette around the
shadows of the tree to “reach-up” with the light.
As you’ll notice, similar areas in this phase were
adjusted during “Global” phase. Some of these
“common areas” have adjustments increasing the effect while others were counter
to those adjustments… Such is the nature of the tonal adjustment “tango” *

[ Sidebar]: * The “Five-Step” Tango
I first heard this “Tango” reference in a lecture by Jack Davis – “The Five
Step Tango”. I found it very descriptive of the “back & forth” adjustments
when processing the digital image.
[Click Here to view a snippet from this wonderful teacher]

Page 107

Processing the Digital Image

The 4 Phases

4-Expressive:
During this expressive phase, I really try to connect with the image. Some
things are more obvious than others, like:
• removing the grate,
• the reflector and
• a knot in the wood 3 boards down from the grate
All easy Photoshop for Photographers techniques.
Then, back to camera raw for more expressive tweaks:
• I revisited the Green Shutters to slightly lighten the
green and open the shadows
• I revisited the Yellow Wall, vignetted top edges and
tapered the brightness darker from top to middle.
What’s Next? Thinking about darkening Shutter
openings to hide the figure within… still pondering if I
want to return the seat for the front bike.
Ah, the benefits of non-destructive processing!

The 4-Phases Larger for Evaluation
1 - Convert
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Pre-Visualization (a little) / Post-Visualization (a lot)
Let’s review the PhotoCycleTM / 4-Phases of processing the “Key Bikes” example.
Pre-Visualized ......................................................................................................
During the moment of capture – there was a definite awareness. I “Felt” the
Key West scene that was dormant in my mind – the temperature and humidity;
the color; the palm trees; etc.
My craft to capture the optimum exposure was in place. Move on to capture
more scenes – maintain that photographic awareness - recall or reshape the
purpose of capture later.
Phase: 1-Converting my “captures” were pre-set with my defaults in my
computer software months/years earlier.
Post-Visualized (Continuing with the 4-Phases) .........................................................
2-Global – “AutoTone” and adjustments to the tonal range of the scene;
3-Selective… focus, not on the tonal range of the scene but, on the tonal
relationship of the subjects in the scene: the yellow wall; the shutters; etc.
4-Expressive… the Photoshop work, revisiting Lightroom for subtle tonal
changes on the shutters, the wall gradient shading, top edges of the photo.
Am I “recalling” or “reshaping” my memory - it doesn’t really matter?
This is all Pre-Visualization… I am creating my Artistic Expression of the scene.
The 4-Phases Larger for Evaluation
3 - Selective

4 - Expressive
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Artistic Expression…Ansel Adams calls it the “Expressive Photograph”
Chita Rivera “liberates from the technical leading
her to freedom of expression”
Achieving artistic expression is a process. I truly believe when processing your
digital image following the PhotoCycleTM 4-Phases workflow will lead to your
expressive photograph.
The first 3 phases of the digital process will not only enhance the captured
data, but you’ll become close with your images. Some may fall short of your
vision… some may be inspiring – the first 3 phases are where this will emerge. It
is not boring or rote… it is a clearing-away, a way to see the potential of your
captured images.
In film/analog photography, there was much “Pre-Visualization” … this was
necessary - the medium was heavily driven by its craft. In digital photography
our goal is to initially capture that gesture, the perspective, the optimum digital
exposure… and then to optimally process that captured data!
The number of tools we’ll need to modify, enhance and express will vary for
each image. The tools we will use cannot be predicted at image capture, or even
when reviewing our thumbnails. As we understand our craft, we’ll be liberated
from the tools to have our freedom of expression.
Digital capture is not like cinéma vérité, capturing footage and then finding it
on the splicing table. It is more like an idea with endless options to express what
we felt when capturing our image.
The digital processing tools are limited only by our imagination… our ability to
pull the art from the stone is the Post-Visualizing to find our “Artistic Expression”.
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Here is an uplifting quote by Imogene Cunningham…

Also, when I look for inspiration, I revisit this interview with Jay Maisel often.
I urge you to watch this short video

Onward!
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A. Processing the Digital Image “Book Links”
Introduction

Book Links by Chapter - For non-PDFBook Reader*s

1st Digital Camera: http://en.wikipedia.org/wiki/Kodak_DCS_100
Adobe Camera Raw History: www.lynda.com/Lightroom-tutorials/short-history-AdobeCamera-Raw-ACR/185329/412684-4.html

Compare Raw Processing - 2005 vs. 2019: www.processingthedigitalimage.com/bookphotos_intro/

1 Basics of PDI

Section I Photos: www.processingthedigitalimage.com/_basic1/
# Digital Image Shot/Year: https://mylio.com/true-stories/tech-today/heres-howmany-digital-photos-will-be-taken-in-2017-repost-oct

Best PHONtography Editing Apps https://iphonephotographyschool.com/bestphotoshop-app/
More Camera-Phone Hardware Attachments

https://www.engadget.com/2018/06/07/best-smartphone-camera-accessories/

3 More Basics of PDI

Section III Photos: www.processingthedigitalimage.com/bookphotos_basic2/

4-Phases

1-Convert: www.processingthedigitalimage.com/bookphotos_4p_1convert/
2-Global: www.processingthedigitalimage.com/bookphotos_4p_2global/
3-Selective: www.processingthedigitalimage.com/bookphotos_4p_3selective/
4-Expressive: www.processingthedigitalimage.com/_4p_4expressive/
4-Photoshop Examples: www.processingthedigitalimage.com/bookphotos_4p_4expressive-psp/
4- Content Aware: https://creativepro.com/which-photoshop-content-aware-feature-should-you-use/

Digital Processing: More Links:
• Digital Image Processing [Click Here]

https://en.wikipedia.org/wiki/Digital_image_processing

• Adaptive technology [Click Here]

https://actcenter.missouri.edu/about-the-act-center/what-is-adaptive-technology/

• Computational Photography [Click Here]

https://en.wikipedia.org/wiki/Computational_photography

refers to the use of digital computation instead of optical processes.

• Epsilon Photography [Click Here] https://en.wikipedia.org/wiki/Epsilon_photography
a form of computational photography where multiple images are
captured with slightly varying parameters (represented by ε )
• Light Field [Click Here] https://en.wikipedia.org/wiki/Light_field
• The Plenoptic Function [Click Here]
http://homepages.inf.ed.ac.uk/rbf/CVonline/LOCAL_COPIES/ASHBROOK1/node4.html

the 5-dimensional function representing the intensity/chromaticity of light
observed from every position and direction in 3-D space.

• Digital Sensors link [Click Here]

Note: I have referenced these sites but do not control them. From time to time the
links may not work… if you find such a link please let me know and I will fix it
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Processing the Digital Image “Book Links” (Continued)
Essential Links:
If you are serious about understanding digital photography, …these links are a must!
Exposure:
1. Bruce Fraser’s Two Definitive White Papers On Digital Exposure
o Raw Capture, Linear Gamma ,and Exposure [Click Here]
www.bobdinatale.com/files/BF_Raw%20Capture%2C%20Linear%20Gamma%20and%20Exposure.pdf

o Understanding Digital Raw Capture [Click Here]

http://www.bobdinatale.com/files/BF_Understanding_DigitalRawCapture.pdf

They are only 4 pages each but will provide the basis for understanding
digital exposures and enable you to get the most out this book.
2. Exposure to the Right – the Genesis
Michael Reichmann is credited as being the father of Exposure to the Right
[ETTR]. Here are two of his articles: the first in 2003 and an update in 2011.
o 2003 [Click Here] http://www.luminous-landscape.com/tutorials/expose-right.shtml
o 2011 [Click Here] http://www.luminous-landscape.com/tutorials/optimizing_exposure.shtml
Informational:
Todd & Zakia - Photographic Sensitometry: The Study of Tone Reproduction
https://www.abebooks.com/servlet/BookDetailsPL?bi=30079275198

Tone Reproduction Cycle - Franklin Institute Journal, Vol.190 – Page 50;
http://books.google.com/books?id=t-UGAAAAYAAJ&pg=PA39&dq=photography+tonereproduction&hl=en#v=onepage&q=photography%20tone-reproduction&f=false

George Jardine "Revisiting the Zone System" [Click Here]

… a must if you want to understand Digital Exposure http://mulita.com/blog/?p=3358
The Pencil of Nature "Fox Talbots’ book” with RFD notes [Click Here]

www.processingthedigitalimage.com/wp-content/uploads/The%20Pencil%20of%20Nature_RFD.pdf

the first commercially published book illustrated with photographs. It was wholly executed by
the new art of Photogenic Drawing, without any aid whatever from the artist's pencil!
Camera Profiling: [Click Here]

https://www.dpbestflow.org/color/camera-profiling

Inspirational
Cartier-Bresson Washington Post Interview (8/5/2004) [Click Here]

• http://www.washingtonpost.com/wp-dyn/articles/A39981-2004Aug4.html

Cartier-Bresson “The Decisive Moment” [Click Here]

• http://www.photohype.com/DecisiveMoment.htm

Jay Maisel Light, Gesture & Color – 8-minute inspiring video [Click Here]
• https://youtu.be/GzQUp02XfAM

The Art of Photography by Karl Lang [Click Here]

Karl Lang explains the importance of understanding the digital craft necessary to support the
Artist’s Vision. A must read.
http://www.lumita.com/site_media/work/whitepapers/files/pscs3_rendering_image.pdf

Note: If you purchased the printed version and would like a PDF version of the book,
please contact me and I will send you a 50% discounted coupon.
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B. Website: Processing the Digital Image - 4-Phases
Pages:

This book has a complementing website
Please check periodically for updates and new downloads

“Home” www.ProcessingTheDigitalIimage.com/
From the home page menu, you will find links to all other site locations…
o “Purchase the Book in all formats [Click Here]
“Digital Processing Examples” www.processingthedigitalimage.com/support/
From the home page menu, under “Book Photos”
“Train With Bob” www.processingthedigitalimage.com/training/
o Schedule Time with Bob for Personal 1-on1 Online-Training
“Bob’s Blog” http://bobd.tv/
o Post your Questions & Comments on the Processing the Digital Image
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C. Submitting Your Photos

Submit Photos
You are invited to submit your photos using the 4 Phase Workflow on the
book’s website. You’ll find these submitted photos under “Book Photos” Menu
“Submitted Photo” menu.
If you would like to submit photos for the PDI website, please fill this form
and email it with your photo. (See the Sample Below)
You can also go to the website’s “Submit Photo” page and fill the form there
www.processingthedigitalimage.com/submit_photos/
Submit Two Photos:
- Phase-1 Convert before any processing & the final processed Image
- Discuss other Phases 4 processing workflow.
Phase-1

Final Image

Processing Tools/4-Phases Workflow
- Global: Lowered contrast; raise black point to enhance fog
- Selective: “spot healing” brush to move plane left for better composition;
brush” to desaturate, lower contrast and add haze to plane; “radial
gradient” vignette to light and lower edged contrast
- Expressive: “brush” to desaturate, lower contrast and add haze to plane;
“radial gradient” vignette to lighten and lower edged contrast
Personal Info:
Your Name: ________________ World Location _____________________
Would you be willing to be part of a Live Online AOI to discuss this
photo with other readers? Yes___ No___
Email To: email@BobDiNatale.com
Subject: “Photo Submission for Consideration to PDI Site
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D. Setting Software Develop Defaults

Setting Software Develop Defaults
Adobe Lightroom allows you to set “Default Develop Setting” specific to your
camera’s model and serial number. When adding files, Lightroom will identify
the camera and apply the appropriate “Default Develop Settings” - if the card
had been used in multiple cameras! (see sidebar below) You can also save a
“custom camera profile” to your settings. (see Appendix E.)
What Settings to use for your Develop Defaults?
- You DO NOT want to save specific “Tone” (Exposure, Contrast, Shadows, etc.
as these would be unique for each image.
- You want to be discreet here... just use those settings that you would want to
apply to every image. (see my defaults below)
How to Set your Camera’s Default Develop Setting?
In Lightroom’s Develop” module:
1. Select a “camera raw” image, right click and “Create Virtual Copy”
2. Restore the “Virtual Copy” to “Adobe Defaults Settings”
by pressing the “Reset” button.
3. From the “Develop” menu choose “Set Default Settings”
4. Holding down the “Alt/Option” key changes the “Reset”
button to “Set Defaults…” then click the “Restore
Adobe Default Settings” button
5. Apply your desired settings to the image: (see my defaults earlier in book)
6. Set Your Camera’s “Defaults Develop Settings” for this specific camera:
a) Again, hold down the “Alt/Option” key to change the “Reset” button to
“Set Defaults…”, now and select “Update to Current Settings” button –
that’s it! (If you have multiple cameras, set defaults for each*).
[Setting Multiple Camera Defaults]

You will need to change the Lightroom Preferences, “Presets” tab to select
“Make defaults specific to camera serial number”. (You can also set for
specific ISOs but that can be more problematic than helpful – your defaults
will only be applied if the file ISO matches the default ISO.
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E. Calibrating Your Camera

Enough can't be said about the need for calibrating your camera. Each
camera senor has its own personality and sees color differently… even from the
same manufacturer and the same model! Calibrating your camera will take full
advantage of your camera’s color and tonality when processing your camera
raw images.
`

Camera Calibration:
Using X-rite’s Passport ColorChecker,
you can create a camera specific profile in
Lightroom for your “Camera Calibration”
setting. This profile will remove each
camera’s unique color bias and increase the
repeatability of colors between multiple
“Calibrated” cameras.
Adobe Camera Raw supports (and X-rite creates) “dual-illuminant” profiles
(Daylight/Tungsten). This will produce more faithful colors across a wider color
illumination range. You can create a LR Develop preset to apply just your
“Camera Specific Calibration” to shots taken with that camera only at any later
time!
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F. The Photographer’s Essential Photoshop Tools

The power of Camera-Raw software and photo Plug-ins has changed the way
we process our digital images. However, Photoshop remains an important tool
for the photographer. Here are the essential Photoshop tools the photographer
needs to know.

Overview

- Layer Basics:
o Learn the Different types of layers and how to - Create; Duplicate;
Scale & Transform; Mask, Add Effects and Clip Layers
- Pixel Replacement:
o removing unwanted elements from your photos… which technique to
use and when
 Clone Stamp; Copy/Cover/Reveal; Layer Via Copy
 Content Aware Fill, Patch, Move
- Plug-ins
o Make sure the work with Photoshop “Smart Objects”

Tools

Layers
Types: Pixel; & Adjustment Mat cover
- Pixel
o “Background” layer unique “Bottom” of stack
o Smart Objects: non-destructive (parametric)
- Adjustment (non-destructive)
 Menu: Layer>New Adjustment Layer
 Layer Palette [New Adjustment Layer] icon:
Working with Layers:
- Making New layer:
o from Menu: Layer>New>”Layer…”
o from Layer Palette [Create a new layer] icon
Working with Layer “Mask”
- Creating Masks: Black Blocks; White is Window
o No Selection:
 Menu: Layer>Layer Mask: Reveal / Hide “All”
 Layer Palette [Add layer mask] icon: click=Reveal / Alt+click = Hide
o With Selections
 Menu: Layer>Layer Mask: Reveal / Hide “Selection”
 Layer Palette: [Add layer mask] icon click Reveal “Selection”/ Alt+click
Hide “Selection”
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The Photographer’s Essential Photoshop Tools (Continued)
Selection - It is ALL about Selections!
- Quick Selection
- Magic Wand :Lasso: polygonal; magnetic lasso
Pixel Replacement – this IS Photoshopping! - remove stop sign,
ex-brother-in-law, etc. Which technique to use… and when
- The Clone Stamp Tool [small areas]
o Tricks and Tips:
 Clone on “blank” layer;
 Change Clone Stamp tool blend “Mode” to Lighten / Darken
- Copy/Cover/Reveal [large areas]
o Copy –a selected area… Menu: Layer>New>Layer via Copy
o Cover
 Move [V] copied “tile” over area to “Cover”
o Reveal
 White Brush on mask
 Black Blocks; White is Window
o Transform [Ctrl/Cmd T]
 Proportional / Non-proportional (distort); Rotate
 Pixels / Mask effects Both when locked; effect Either by unlocking mask
- Refine Masks:
Basic ...........................................................................................................
o With Brush… Black Blocks; White is Window
 Soft/Hard Edge; Keyboard [X] flips Fore/Background colors; [D] sets
default colors)
o “Blur” tool: brush/rub edges of “mask” to soften mask edges
o Filters:
 Blur; Blur More; [Ctrl F; Ctrl F]; History; Ctrl+Z
 Gaussian Blur
Advanced....................................................................................................
o Refine Edge command [J.Kost Video_Click Here] https://youtu.be/H5vT0lyKSTg
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The Photographer’s Essential Photoshop Tools (Continued)
Content Aware
All Photoshop’s Content-Aware tools use Artificial Intelligence to replace
pixels on pixel layers.
- Content-Aware Fill
o Select the area you want to remove
o from the Edit menu, select: Fill >Content Aware
 this tool will find pixels like those in the area you selected and replace
the unwanted pixel. The selected pixels will be blended into the scene
- Content-Aware Scale
o Allows non-proportional scaling (change the aspect ratio) without
“distorting” any important elements in the image!
o It scales areas with similar pixels while it does not-scale dissimilar pixels.
“Scale” has a setting where you can manually select specific areas you
want protected.
- Content-Aware Move
- With this tool, you “move an object” in the photograph to another
area. Photoshop will try to "fill" the vacated area based on the
image content.
- Content-Aware Patch (the reverse of “Move”)
- With this tool, you “move an area” in the photograph to cover an
area. Photoshop will try to "Patch" the object with the moved area.
 Replaces an area using a pattern or pixels from another part of the
image.
Plug-ins (Photoshop’s “Filters” Menu are their Plug-ins)
Filters apply an effect without needing to know the many
sophisticated steps to create the same effect.
- Photoshop’s “Filters” Menu are their Plug-ins
- Photoshop’s “Filter Gallery” allows to combine many filters. You can create
and save your personal unique effect
o Used on a “Smart Object”, filters become “Smart Filters” which are
non-destructive and re-editable
- 3rd Party Plug-ins
o Should preferably supports “Smart Object’s to maintain a non-destructive
and re- editable workflow!!
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G. Instructions for Printing this PDF Book
The PDF version of this book is “printable”. The page size of the book is 8 ½ x 5 ½.
If you have a printer capable of printing on both sides of the paper, printing in
“booklet” form It is quite easy using standard “Letter” size paper.
Then, using Adobe Acrobat Reader 10.0 or higher:
Under the “File” menu:
1. Select “Print” (choose printer and set
“Letter” size paper.
a. Pages to Print: All
b. “Page Sizing & Handling” menu, choose
“Booklet”
- “Sheets from: will tell the # of sheets of paper you’ll need
2. Orientation: Portrait
3. Click the “Print” button to start printing

You should be able to fit the entire book on approximately 30 sheets of
paper. When done, simply fold in full letter size paper in half… and find a stapler
with long staples!
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Compendium

Mobile Photography
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Mobile Photography
PHONtography and Photo Adjustments
As I mentioned in the intro, Mobile Photography has an important place in
today’s Digital Photography. This section discusses the PhotoCycleTM and the
4-Phases of digitally processing your mobile photography.
The Camera-Phone Workflow
Again, it is important to restate that you don’t process every photo you
shoot. It’s similar to shooting with a DSLR or a point-and-shoot camera. You
review your images, then you process just the “Selects”.
A good time to process your “select” photos is just before you are about to
share your photo – Facebook; Instagram; emailing etc.. If you want to be known
as a good photographer, remember…
“A photographer is known by what they show – not what they shoot”
Phase 0: Capture
• First and foremost - clean the lens. This phone has been in pockets; purses;
jeans and grabbed with no awareness if your fingertips are touching the
lens!
• Steady your camera-phone. Lean against a building; burry you elbows in your
ribs and press the camera-phone against your forehead. (a.k.a. “a tripod”)
Phase 1: Convert
• Phone Capture Settings:
o If your phone supports it, capture in
camera raw (DNG). The reasons for
not using a JPG format is even more
exaggerated in mobile photography.
o set your camera-phone “capture
defaults” set “in-the-ready” prior to
shooting. Priority of settings:
 Camera Raw (DNG) – if available, if not HDR
 slight overexposure: +.3 EV bias
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Phase 2: Global [Phone Processing Software]
• Crop: helps focus viewer on your subject; consider a way to tell your story
• Auto Tone (Magic Wand): moderates highlights; shadows; tonal relationships
• Brightness/Exposure Adjustment:
o AutoTone balances tonal relationships and the “Blacks” & “Whites”
points”… but many times a slight + or - brightness adjustment is needed
…Share processed photo to Facebook; Instagram; email; etc.
<< That’s it - simple, fun and respecting the viewer of your photograph! >>

Phase 3: Selective [Phone Processing Software]
Most camera-phones have advanced editing software
features to address selective areas of your photograph.
Using sliders and masking for exposure; highlights;
shadows; contrast; blacks; etc.
Controlling the sliders on the small screen and the bright
environment (outside) is not conducive to make fine
adjustments. However, I do reach for these controls to fix
something egregious in a capture I am about to share.
3rd-Party software
There are many 3rd-party software apps for camera-phones that extend the
mobile-processing experience:
o some have very advanced processing features;
o some allow you to capture photos in camera-raw (DNG)…
o many are free!
The most friendly and powerful camera-phone app that fully supports my
PhotoCycleTM and the 4-Phases of processing is Adobe’s Lightroom Mobile:
o it captures Raw (DNG);
o supports “Non-destructive” editing,
o and handshakes easily with Photoshop.
More apps and hardware for camera-phones are discussed following the
“Quick-Mobile-Process” workflow example.
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THE 4-Phases: Mobile-Processing the Digital Image

Before sharing your photo, be attentive… here is where you can show
respect for the viewer’s time looking at your photo. I think it is a good time to
recall Jay Maisel’s quote: “You are responsible for every part of the photo… even
the parts you’re not interested in”.
What follows is a typical “quick minimal-process” for each photo you want to
share.
I will take you through the entire 4 Phases PhotoCycleTM workflow. There is
a brief discussion about capturing this image as it effects the 4-phases
processing workflow.
Minimal “Quick-Process” Before Sharing Your Camera-Phone Photos
iPhone Moment of Capture

iPhone Artist’s Vision

Phases 0-Capture & 1-Convert
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Phase-2 Global
POST-Crop

PRE-Crop

Crop

Magic Wand - BEFORE

Magic Wand - AFTER

AutoTone (Magic Wand):

Brightness Adjustment

Brightness/
Exposure Adjustment:
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Phase3 Selective
3- Selective Adjustments 3- Selective SHADOWS

Advanced Editing
Menu
Shadows

Shadows - BEFORE

Shadows - AFTER

Shadows
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Camera-Phone Apps & Hardware Attachments
There are many apps and hardware attachments that will assist your MobilePhotography digital image processing... most Apps are free. Hardware can also
expand your Moment of Capture photography options.
Camera-Phone Editing [Apps]
Of the many to choose from, the most productive for me is Lightroom
Mobile. It has most all digital processing features of the desktop version – and,
it’s free. If you have Adobe’s “Photographer’s Subscription” you can upload your
camera-phone’s raw (DNG) captures to your desktop for further non-destructive
processing.
Other apps you may want to explore are listed below.
• Adobe Lightroom Mobile App - Free
o Lightroom Mobile Adobe
 1-Capture Raw (DNG) and HDR file format
 Supports All 4 Phases PIE Non-destructive editing
 Uploads my camera-phone raw captures to my home desktop
• Google’s “Snapseed”: a complete and professional photo editor
o a powerful photo editing app - has all the basic photo editing software plus
many advanced features. All edits are non-destructive
• Other Adobe Free Mobile Apps
o Express: a free mobile app for making quick, powerful, and easy photo
edits and creating collages.
o Fix: enables powerful easy image retouching and restoration. Features
heal, smooth, liquify, lighten; etc.
o Mix: offers Photoshop’s layers and advanced tools… remove objects from
our photos, combine multiple images, work with different layers.
o 645 PRO: turns your Camera-Phone into a fully working manual camera!
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Camera-Phone [Hardware]
• Dr. Russell Brown - Mobile Processing Master Hardware Links:
o Mobile Phone Pocket Tripod: [Click Here]
 The L-Clamp Phone Clamp: [Click Here]
 The Micro Ball Head: [Click Here]

o Aerial Photography: (Best travel copter)The Mavic 2 [Click Here]
o Best 360 Degree Camera - Ricoh Theta Z1: (works w/Lightroom) [Click Here]
o Best Camera Phone for night photography: Huawei P30 Pro: [Click Here]

• More Camera-Phone hardware attachments [Click Here]
My Limitations to Camera-Phones
I don’t do a lot of camera-phone photography because of the limitations of
interchangeable lenses. I am very aware of “perspective”- the relationship
between object in my photo.
By changing my camera position to alter the relationship of objects in my
photograph, I then fill the view finder with different focal length lenses on my
DSLR camera.
This is very different than “pinch-zoom” with your Camera-Phone. “Pinchzoom” with most Camera-Phones does not “zoom-in” but crops the number of
pixels your image will use. This results in less mega-pixels per capture and
therefore less image quality.
Using you Smart-Phone as Your Prime Camera
If you want to really think of having your Camera-Phone as your prime
camera, consider additional lenses from Moment Products. You can do quality
telephoto, wide-angle and macro image captures. These quality, small profile
lens makes for really light-weight traveling photo-gear [Click Here]
Moment Products https://www.shopmoment.com/
o Lenses: https://www.shopmoment.com/shop/categories/lenses
o Wide Angle: 18mm: .63mag https://www.shopmoment.com/shop/wide-18-mm-lens
o Telephoto: 58mm 2x/4x mag https://www.shopmoment.com/shop/tele-58-mm-lens
o Marco Visual: 10X mag https://www.shopmoment.com/shop/macro-lens

Page 20

Processing the Digital Image

The 4 Phases

Creating Collage
- Open files to be included in the collage as "Smart Objects":
a. if files are already a pixel Layer... "Convert Layer to Smart Object"
before “transforming”
- Copy each image into one open "Parent” document:
b. Set Photoshop Desktop to "Tile" mode
c. From the Layer Palette of each image, drag the Layer in to the
"Parent” document.
- Set Canvas Size to Final Output Size:
d. Menu: Images >Canvas Size
Note: Ignore Any Clipping Warnings
- Arrange the Layers to Create Final Collage Layout
e. scale / re-scale / distort / rotate etc.
f. add Layer “Styles”:
i. drop shadows/beveled edges/edge stroke/etc.
ii. Copy “Style” and “Paste” to all layers in the Collage for
consistency
- Save
g. Reopen and continue to design and rearrange if necessary.
Transform and move images as many times as you wish... all these
adjustments are Non-Destructive !
Anatomy of an image (AOI)
RFD …process for demonstrating the “4 Phases” of Digital Image Processing
- Create 5“Snapshots” from the final version naming them appropriately:
0 Capture; 1 Import; 2 Global; 3 Selective; 4 Expressive
- Adjust all but the last "Snapshot" accordingly:
0. Select "Snapshot" #0 and apply LR Preset “AOI 1 Import”
a. remove any Adjustment Brush or Gradient Filter
b. then Update Snapshot 0 & 1
1. Select "Snapshot" #1 and apply LR Preset “AOI 1 Import” then Update
2. Select "Snapshot" #2 and apply LR Preset “AOI 2 Import”
a. remove any Adjustment Brush or Gradient Filter then
“update”
3. Select "Snapshot" #3 might remove some of the top "Expressive"
AB/GF are then update snapshot leaving difference for 4th Snapshot
Note: if any additional "Expressive" fine-tuned adjustments are made you can
always update "Snapshot" 4 or add snapshot 4a,b etc.
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Pixel Replacement
With Large Areas... use Copy/Cover/Reveal
1. Select “Tile” area to copy
2. Copy selected pixels to new layer
- Menu: Layer>New>Layer Via Copy
- From keyboard: [Ctrl/Cmd + J]
3. Move the “Tile” to cover the desired area
4. Add Black Mask To “Tile” layer
- Menu: Layer >Layer Mask >click mask icon on the latest health
Hide Selection
- on Layers palette, [Alt/Option + click “Mask” icon
5. Reveal pixels below by painting with a “white brush” on the mask
- If you revealed too much the switch brush color to black to
“block” pixel
- for irregular edges, use the "Magnetic Lasso" then paint area with
white brush
a. repeat as needed for other areas
6. Soften/Feather “Mask” Edge
- When using the lasso tool you might want to soften edges
- Filter: "Blur More"... repeat filter -- [Ctrl/Cmd + F]
- use "Blur Tool" to alert edges of the mask
With Smaller Areas Use the "Clone Stamp Tool"
1. Create a new "Blank Layer"
a. Menu: Layer >New
b. on the Layers palette, click "New Layer" icon
2. Set "Clone Stamp Tool" To "Current And Below"
a. this adds “cloned pixels” to the blank layer
b. you can “mask” or “erase” these pixels without affecting the pixels
below
c. Tip: you can also set the "clone stamp tool Dad" "mode" to darker
or lighter this will also moderate any repeating patterns
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